HeartStart Configure
User Guide
About this edition

Configure version 3.1

Publication date: December 2012

Document part number: 453564239034

The information in this document applies to the product version indicated above. This information is subject to change without notice.

Philips Healthcare shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of the material.

Copyright

Copyright © 2012

Philips Electronics North America Corp.

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or computer language in any form by any means without the consent of the copyright holder.

Unauthorized copying of this publication may not only infringe copyright but also reduce the ability of Philips Healthcare to provide accurate and up-to-date information to users and operators alike.

Medical device directive

Philips HeartStart Configure complies with the requirements of the Medical Device Directive 93/42/EEC and carries the mark accordingly.

Trademarks

Philips HeartStart Configure, HeartStart FR3, HeartStart FRx, HeartStart HS1, HeartStart Defibrillator, and the HeartStart logo are either trademarks or registered trademarks of Koninklijke Philips Electronics N.V.

The Philips HeartStart Configure application uses Bluetooth wireless technology. The Bluetooth wordmark and logos are either trademarks or registered trademarks of Bluetooth SIG, Inc. The Bluetooth wordmark and logos are owned by Bluetooth SIG, Inc.

IrDA is a registered trademark of Infrared Data Association.

Acrobat and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries. Microsoft® Windows, Windows XP, Windows Vista, Windows 7, Windows Explorer, Microsoft .NET Framework, and Internet Explorer are either trademarks or registered trademarks of Microsoft® Corporation in the United States and/or other countries.

Authorized EU Representative

Philips Medizin Systeme
Boeblingen GmbH
Hewlett-Packard Strasse 2
71034 Boeblingen, Germany
(+49) 7031 463-2254

Device manufacturer

Philips Medical Systems
22100 Bothell Everett Highway
Bothell, WA 98021-8431, USA

FEDERAL LAW (USA) RESTRICTS THIS DEVICE TO SALE BY OR ON THE ORDER OF A PHYSICIAN.

EN 10/8/2012
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome to Philips HeartStart Configure</td>
<td>7</td>
</tr>
<tr>
<td>Indications for use</td>
<td>7</td>
</tr>
<tr>
<td>Conventions used in this guide</td>
<td>8</td>
</tr>
<tr>
<td>Finding software updates</td>
<td>8</td>
</tr>
<tr>
<td>Installing HeartStart Configure</td>
<td>9</td>
</tr>
<tr>
<td>System requirements</td>
<td>10</td>
</tr>
<tr>
<td>Securing your software</td>
<td>11</td>
</tr>
<tr>
<td>Using the installation CD-ROM</td>
<td>11</td>
</tr>
<tr>
<td>Starting HeartStart Configure</td>
<td>12</td>
</tr>
<tr>
<td>Uninstalling HeartStart Configure</td>
<td>13</td>
</tr>
<tr>
<td>Activating the software</td>
<td>15</td>
</tr>
<tr>
<td>Activating the software by Internet</td>
<td>15</td>
</tr>
<tr>
<td>Activating the software by email</td>
<td>16</td>
</tr>
<tr>
<td>Introducing HeartStart Configure</td>
<td>19</td>
</tr>
<tr>
<td>What is Configure?</td>
<td>19</td>
</tr>
<tr>
<td>Who uses Configure?</td>
<td>20</td>
</tr>
<tr>
<td>Configuring a defibrillator</td>
<td>21</td>
</tr>
<tr>
<td>Selecting accessories</td>
<td>22</td>
</tr>
<tr>
<td>How to use HeartStart Configure</td>
<td>25</td>
</tr>
<tr>
<td>Using the Navigation and Help panes</td>
<td>27</td>
</tr>
<tr>
<td>Using the workspace</td>
<td>28</td>
</tr>
<tr>
<td>Understanding the Getting Started workspace</td>
<td>28</td>
</tr>
<tr>
<td>Understanding the Configurations workspace</td>
<td>28</td>
</tr>
<tr>
<td>Understanding the Administration workspace</td>
<td>30</td>
</tr>
<tr>
<td>Using Click Mode</td>
<td>30</td>
</tr>
<tr>
<td>Changing defibrillator settings</td>
<td>31</td>
</tr>
<tr>
<td>Working with HeartStart FR3 defibrillators</td>
<td>33</td>
</tr>
<tr>
<td>Typical HeartStart FR3 configuration tasks</td>
<td>33</td>
</tr>
<tr>
<td>Preparing the HeartStart FR3 to transfer configurations</td>
<td>34</td>
</tr>
<tr>
<td>Using Bluetooth connections</td>
<td>36</td>
</tr>
<tr>
<td>Setting up the Bluetooth connections and adapters</td>
<td>37</td>
</tr>
</tbody>
</table>
# Table of contents

Using an SD card to configure a HeartStart FR3 ........................................ 37
Retrieving a HeartStart FR3 configuration .................................................... 37
Modifying a HeartStart FR3 configuration ..................................................... 39
Sending a HeartStart FR3 configuration ......................................................... 40
Setting the HeartStart FR3 clock ................................................................. 42
Setting the HeartStart FR3 language ............................................................. 44
Working with HeartStart FRx defibrillators ................................................... 49
   Typical HeartStart FRx configuration tasks ................................................. 49
   Configuring HeartStart FRx AEDs for hands-only CPR .............................. 50
   Setting up infrared connections and adapters ............................................. 51
   Preparing the HeartStart FRx to transfer configurations ............................ 51
   Retrieving a HeartStart FRx configuration ............................................... 52
   Modifying a HeartStart FRx configuration ................................................. 53
   Sending a HeartStart FRx configuration .................................................. 55
Working with HeartStart HS1 defibrillators .................................................. 57
   Typical HeartStart HS1 configuration tasks ................................................. 57
   Configuring 2005 and 2010 HeartStart HS1 AEDs for hands-only CPR ......... 58
   Setting up infrared connections and adapters ............................................ 58
   Preparing the HeartStart HS1 to transfer configurations ............................ 59
   Retrieving a HeartStart HS1 configuration ............................................... 61
   Modifying a HeartStart HS1 configuration ............................................... 62
   Sending a HeartStart HS1 configuration .................................................. 63
**Working with saved configurations** ....................................................... 65
   Creating and saving configurations .......................................................... 65
   Opening previously saved configurations ................................................. 66
   Exporting a configuration file ................................................................. 67
   Importing a configuration file ............................................................... 67
   Deleting configurations ............................................................................ 68
**Working with the System Log** .................................................................. 69
   Opening the System Log ........................................................................... 69
   Viewing the System Log ........................................................................... 70
   Displaying information in tables ............................................................... 71
      Working with columns ...................................................................... 71
   Sorting information in columns ................................................................ 71
   Grouping information in columns ............................................................ 72
**Confirmation Messages** ........................................................................... 75
**Contacting Customer Support** .................................................................. 77
   Getting help ......................................................................................... 78
   Helping us help you ............................................................................... 79
## Table of contents

**Configuration parameter field descriptions** .................................................. 81  
   HeartStart FR3 configuration parameters .................................................. 82  
   HeartStart FRx 2005 and 2010 guidelines configuration parameters .......... 92  
   HeartStart FRx 2000 guideline configuration parameters .......................... 98  
   HeartStart HS1 2005 and 2010 guidelines configuration parameters ............ 104  
   HeartStart HS1 2000 guidelines configuration parameters .......................... 110  

**System Log messages** .................................................................................. 115  

**Glossary** ........................................................................................................ 119  

**Index** ............................................................................................................. 125
[This page intentionally left blank]
Welcome to Philips HeartStart Configure

Use Philips HeartStart Configure (HeartStart Configure) to configure your HeartStart HS1, HeartStart FRx, and HeartStart FR3 defibrillators. This software helps you change your defibrillator based on your medical director’s desired protocol for response to a sudden cardiac arrest (SCA) emergency.

The HeartStart Configure user guide and the help system both provide instructions for performing common configuration tasks. Use the table of contents to access topics. You can also use a full-text search for topics, and view and print instructions.

You can access the user guide in two ways:

- In the Help menu, click HeartStart Configure User Guide.
- In the Windows Start menu, click All Programs, click Philips HeartStart Configure 3.1, and then click User Guide.

Indications for use

HeartStart Configure enables an administrator to configure HeartStart FR3, HeartStart FRx, or HeartStart HS1 defibrillators based on a medical director’s desired protocol for response to a sudden cardiac arrest emergency. Configuration settings for HeartStart FR3 are changed via Bluetooth or data card, whereas configuration settings for HeartStart HS1 and HeartStart FRx are changed via infrared port. Current configurations are retrieved from, modified, and transmitted back to the AEDs. Configuration settings can be saved to a computer for future use or for use on other AEDs.
Conventions used in this guide

The following conventions are used to help identify information.

- A red box with a triangular warning icon and exclamation mark identifies circumstances that could affect defibrillator behavior.
- A yellow box with a triangular caution icon and exclamation mark identifies circumstances that can result in data corruption or information loss.
- A blue box with a note icon contains information on how features are used.
- A green box with a light bulb tip icon contains information to help you complete a task.

Using online help

In the online help system, you can search for information using the full-text search feature, the glossary, or an index.

Use these methods to access online help.

- Press the F1 key to open online help for the selected feature.
- Click the Help tab to show and hide help that is related to the feature you are using. This online help pane appears to the right of the workspace.
- Click the help button on the toolbar.
- In the Help menu, click HeartStart Configure Help.

Finding software updates

From the Help menu, click Check for Updates. If any updates are currently available, they are listed there, with links to the download page.
Installing HeartStart Configure

This topic describes how to install Philips HeartStart Configure software, identify the system requirements, use the installation CD-ROM, start the software, and uninstall HeartStart Configure from your computer.

HeartStart Configure is shipped with a CD and two printed materials: the Quick reference guide, and a Proof of Purchase Certificate.

- The CD contains the HeartStart Configure software, the HeartStart Configure user guide, and a ReadMe file.
- The Proof of Purchase Certificate contains the product serial number you will need to activate the software.
- The Quick reference guide contains the system requirements and installation instructions.

Use the CD to install HeartStart Configure on your computer. Ensure that your computer meets the recommended system requirements to install and run this software.

Once you insert the CD into your computer, the installation wizard automatically runs and prompts you to install the software. In certain cases, you will need to manually start the setup program to run the installation. For more information, see Using the installation CD-ROM on page 11.

You must activate your software the first time you use it. You can do this either by Internet or by email. The preferred activation method is by Internet, since there is no waiting period. However, if you need to activate your software using email, see Activating the software by email on page 16.
System requirements

These tables describe the minimum requirements to run HeartStart Configure.

Software requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft® Windows XP™ Professional, or Microsoft® Windows 7™ Professional (32- or 64-bit)</td>
</tr>
</tbody>
</table>

Hardware requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor speed</td>
<td>Minimum: 1 GHZ x86 or x64 processor</td>
</tr>
<tr>
<td>Display</td>
<td>Minimum: 1024 x 768</td>
</tr>
<tr>
<td></td>
<td>Recommended: 1280 x 1024 or higher</td>
</tr>
<tr>
<td>Disk space</td>
<td>Required: 300 MB of available disk space during software installation</td>
</tr>
<tr>
<td>Internet connection</td>
<td>Required connection to activate the application software and to receive software updates</td>
</tr>
</tbody>
</table>

Accessories

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF Reader</td>
<td>Such as Adobe Acrobat Reader X. Required to view the HeartStart Configure user guide</td>
</tr>
<tr>
<td>HeartStart FR3 Secure Digital (SD) card</td>
<td>Required if you configure an FR3 defibrillator using a secure digital (SD) card</td>
</tr>
<tr>
<td></td>
<td>For help choosing a secure digital (SD) card, see Selecting accessories on page 22.</td>
</tr>
<tr>
<td>Email client (MAPI-compliant)</td>
<td>Required to complete software installation if you are activating the software by email</td>
</tr>
</tbody>
</table>
### Component Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Infrared Data Association (IrDA) adapter (for HeartStart FRx and HeartStart HS1 only) | Required to retrieve and send information to and from HeartStart HS1 or HeartStart FRx defibrillators  
Infrared adapters are available from Philips.  
For help choosing an infrared adapter, see Selecting accessories on page 22. |
| Card reader (for HeartStart FR3 only)                                   | Required if you configure an FR3 defibrillator using a secure digital (SD) card  
For help choosing a card reader, see Selecting accessories on page 22. |
| Bluetooth adapter (only for HeartStart FR3 equipped with Bluetooth)     | Required if you configure an FR3 defibrillator using the Bluetooth 2.0 wireless transfer interface  
For help choosing a Bluetooth adapter, see Selecting accessories on page 22. |

### Securing your software

After installing HeartStart Configure, you are responsible for ensuring its security.

This could involve both physical security (limiting access to the spaces where the computer is stored) and user account access control. Philips recommends you follow the Microsoft Windows security policy or the policy of your organization.

### Using the installation CD-ROM

You must use the installation CD-ROM to install HeartStart Configure on your computer. You can install HeartStart Configure on only one computer for each license.

If you need to reinstall this software on your computer or install it on a different computer, you must first uninstall the software.

The CD contains:

- Philips HeartStart Configure software
- *HeartStart Configure user guide* and *Quick reference guide*
• A ReadMe file that describes the software release. The ReadMe file might also contain late-breaking news related to the software release.

You must have administrator privileges to install HeartStart Configure.

To install from the CD

You can install Philips HeartStart Configure to the default location, or select a preferred destination folder.

1. Insert the Philips HeartStart Configure CD in the drive on your computer. The Philips HeartStart Configure installation wizard should start automatically. If it does not, then use Windows Explorer to browse the CD for the Configure31Installer.exe file, and double-click it.

2. Click **Install** to start the installation, and follow the on-screen instructions.

3. Click **Finish**.

Starting HeartStart Configure

After installation, HeartStart Configure is available from the All Programs menu.

**To start Philips HeartStart Configure**

1. Click **Start**, and then click **All Programs**.

2. Click **Philips HeartStart Configure 3.1**, and then click **Configure**.

Also available from the All Programs menu under Philips Configure 3.1 is the Hands-only CPR Wizard. Selecting this option allows you to begin configuring your HeartStart HS1 or HeartStart FRx defibrillators for hands-only CPR without the need to first open the HeartStart Configure application.
Uninstalling HeartStart Configure

If you want to reinstall HeartStart Configure on your computer or install the software on a different computer, you must uninstall the software from your computer while it is connected to the Internet.

You cannot activate and use the software on a different computer until you have first uninstalled and deactivated the software on the current computer.

If you do not have an Internet connection, see Contacting Customer Support on page 77.

To uninstall Philips HeartStart Configure from your computer

1. Verify that your computer is connected to the Internet.
2. From the Start menu, click Control Panel.
3. Click Programs, and then Programs and Features. Uninstall or change a program appears.
4. On the list, click Philips HeartStart Configure 3.1.
5. Click Uninstall.
[This page intentionally left blank]
Activating the software

In order to use Philips HeartStart Configure, you must first activate your software. You can do this either by Internet (in which case you must have an Internet connection on your computer) or by email.

Activating the software by Internet

Philips recommends that you activate your software by Internet, since there is no waiting period to use the software using this method.

Your computer must have an Internet connection in order to immediately activate and use your software.

To activate the software by Internet

2. In the Serial Number box, type the product serial number that you received.
   
   Your serial number is an 18-digit alphanumeric code under a bar code; see 1 in the following figure.

   All "0" characters are numeric zero.
3. Click **I want to activate the software over the Internet.**
4. Click **Activate.**
   A confirmation message states that the software is ready for use.

**Activating the software by email**

Using the Internet to activate HeartStart Configure is the preferred activation method.

If you cannot activate your software over the Internet, however, then you can click **email Philips Activation Support.** If you need help, contact Customer Support. However, support for issues that involve email activation is available only in English.

Activation by email can take several business days. During this period, you cannot use the software. Please allow sufficient time for your request to be processed.

After Philips Customer Support receives your email activation request, you will receive an email with the activation code.

You must have an email application installed on the computer that runs HeartStart Configure. If an email application is not on your computer, then see **Contacting Customer Support** on page 77.

**To send the software activation request by email**

1. In the HeartStart Activation Wizard, type the product serial number that you received into the **Serial Number** box.
2. Click **I want to activate the software by email.**
3. Click **Next.**
4. Click **Request Activation Code** to open your email application. Your email application opens a new message with the Activation.bin file attached. You can type additional information as needed.
5. Click **Send** to send the activation request email to Philips Customer Support. Customer support will send you an email with the activation code.

**When you receive an email from Customer Support**

1. Start HeartStart Configure.
   The HeartStart Activation Wizard appears.
2. Click **I want to activate the software by email.**
3. Click **Next** to access the Activate by Email page.

4. Type the activation code that you received from Customer Support in the **Enter your activation code here** field.

5. Click **Activate**.

   The wizard displays a confirmation message. Your software is ready for use.
[This page intentionally left blank]
Introducing HeartStart Configure

HeartStart Configure is a software product used to configure your HeartStart FR3, HeartStart FRx, or HeartStart HS1 defibrillator based on your medical director’s desired protocol for response to a sudden cardiac arrest (SCA) emergency.

HeartStart Configure is a medical device according to US Food and Drug Administration (FDA) and EU medical device requirements.

This software sends a new configuration to your defibrillator using one or more methods.

Philips HeartStart Configure software helps you configure a HeartStart defibrillator. With this software, you can do the following:

• Use menu options and workspaces that help you to retrieve the current configuration setting from your Philips HeartStart AED
• Send a configuration from your computer to a defibrillator
• Create, edit, save, and delete configurations, and make them available for use on another computer that runs HeartStart Configure
• Use wizards to guide you through defibrillator configuration steps

What is Configure?

With HeartStart Configure, you can manage a defibrillator configuration on your computer, doing any of the following:

• Retrieve and modify an existing configuration, and then send the modified configuration to your defibrillator
• Create and save a configuration for reuse later to standardize the behavior of an entire fleet of defibrillators
• Exchange configurations with other users on computers that run HeartStart Configure so that they can standardize the behavior of their defibrillators

To create or modify a configuration, you do not have to be connected to your defibrillator. You can use HeartStart Configure to create a configuration on your computer, and then send the configuration to your defibrillator later.

HeartStart Configure uses a common set of tasks to help you change the settings on your HeartStart FR3, HeartStart FRx, or HeartStart HS1 model defibrillators. The following is a common task:

1. Establish a connection between HeartStart Configure and the HeartStart defibrillator to retrieve the defibrillator's current configuration.
2. In the Configurations workspace, modify the defibrillator configuration.
3. Send the modified configuration to the defibrillator to set its behavior in an emergency setting.
4. Save the configuration for reuse later on other defibrillators.

You can also use HeartStart Configure to import configurations created in older programs, such as Event Review 3.5.

Who uses Configure?

Typical HeartStart Configure users include Automated External Defibrillator (AED) program administrators, medical directors, hospital biomedical engineers, and emergency medical technicians. They do the following:

• View and update defibrillator configurations to determine defibrillator behavior during an emergency
• Set the HeartStart FR3 date and time, modify language settings, and enable bilingual operation

The System Administrators or IT users install the software, view and manage system activity, and perform troubleshooting activities.
Configuring a defibrillator

To configure a defibrillator, you should first retrieve the current configuration from the defibrillator, view it, change its settings, and then send it back to the defibrillator.

You can also save this configuration for later use to standardize the setting of other defibrillators or a fleet of defibrillators.

Changing configuration parameter settings affects the way that a defibrillator performs in an emergency. Only authorized personnel should change the configuration of a defibrillator under the supervision of a medical director.

Configuration settings differ for each defibrillator model. When you configure a HeartStart defibrillator, you change the default settings entered in the defibrillator's memory at the factory.

The method used to send configuration information from the defibrillator to Philips HeartStart Configure and back again varies for each defibrillator model. The HeartStart FR3 uses Bluetooth or a secure digital (SD) card to transfer a configuration, while the HeartStart FRx and HeartStart HS1 both use infrared (IrDA) to transfer configuration information.

The following table lists topics that help you configure a HeartStart defibrillator.

**Configuration topics**

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve and view a defibrillator configuration</td>
<td>See the appropriate topic for the HeartStart defibrillator model:</td>
</tr>
<tr>
<td></td>
<td>Retrieving a HeartStart FR3 configuration on page 37.</td>
</tr>
<tr>
<td></td>
<td>Retrieving a HeartStart FRx configuration on page 52.</td>
</tr>
<tr>
<td></td>
<td>Retrieving a HeartStart HS1 configuration on page 61.</td>
</tr>
<tr>
<td>Change and save the configuration settings</td>
<td>See the appropriate topic for the HeartStart defibrillator model:</td>
</tr>
</tbody>
</table>
## Selecting accessories

Select the accessory you need for your defibrillator model or computer. Accessories are identified by a reference number. To order an accessory, contact your local Philips representative. For more information, see Contacting Customer Support on page 77.

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer IrDA adapter</td>
<td>Product ID: ACT-IR</td>
</tr>
<tr>
<td></td>
<td>ACTSYS ACT-IR4002US or any Infrared Data Association (IrDA) approved adapter. Philips offers an approved adapter: PN ACT-IR.</td>
</tr>
<tr>
<td>HeartStart FR3 defibrillator Bluetooth wireless technology transceiver module</td>
<td>Product ID: 989803150081</td>
</tr>
<tr>
<td>Accessory</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HeartStart FR3 Language Card</td>
<td>Product ID: 989803150101</td>
</tr>
<tr>
<td>HeartStart FR3 Secure Digital (SD) card</td>
<td>Product ID: 989803150061</td>
</tr>
</tbody>
</table>
| Secure Digital (SD) card reader               | Product ID: M3524A  
You can use any Microsoft®-compatible SD card reader. For more information, see [http://www.microsoft.com/hardware/default.aspx](http://www.microsoft.com/hardware/default.aspx)  
Philips offers an approved card reader: PU M3524. |
| Bluetooth adapter for the PC                   | Product ID: 861488  
Or other Bluetooth adapter that supports either the Microsoft Bluetooth stack or the Widcomm Bluetooth stack. |
[This page intentionally left blank]
How to use HeartStart Configure

When you first start the software, you see the screen divided into sections, called "panes." The navigation pane on the left contains links that you can use to select tasks. Selected tasks are displayed in the workspace to the right of the navigation pane.

To access the workspaces

Use the navigation pane to select the workspaces. See the following links for more information about each workspace.

- The Getting Started workspace includes links to information on how to update to 2010 guidelines "hands-only CPR" settings, use the software, select accessories, and check for software updates. This workspace appears when you start the software.
  See Understanding the Getting Started workspace on page 28.

A wizard is available for configuring hands-only CPR for the HeartStart FRx or HeartStart HS1 defibrillators, as described in Guidelines 2010. There are links to the wizard from the Getting Started workspace.

For more information about the Hands-only CPR Wizard, see the following topics:

- For HeartStart FRx, see Configuring HeartStart FRx AEDs for hands-only CPR on page 50.
- For HeartStart HS1, see Configuring 2005 and 2010 HeartStart HS1 AEDs for hands-only CPR on page 58.

- In the Configurations workspace, you can configure a defibrillator. You can also set the HeartStart FR3 date and time, and change the language settings for HeartStart FR3 defibrillators.
  See Understanding the Configurations workspace on page 28.
- The **Administration** workspace displays the System Log of software activities.
  See [Understanding the Administration workspace on page 30.](#)

**To access online Help**
- Press **F1** to display the help contents or (on the menu or toolbar) click **Help** and then click **HeartStart Configure Help**.
- You can also click the **Help** tab on the right side of the window to open the Help pane. A Help topic appears for the workspace that you are using. Click **Related Topics** to navigate to other supporting topics.

**To access the user guide**
- On the menu, click **Help**, and then click **HeartStart Configure User Guide**.

The first time that you start the software, the navigation pane is open. For a description of how to use the pane, see [Using the Navigation and Help panes on page 27.](#)

The following illustration describes available navigation buttons, features, and links in HeartStart Configure:
Using the Navigation and Help panes

The Navigation pane provides quick access to features in HeartStart Configure. For example, when you click the Configurations button, the Navigation pane displays Configuration Tasks and Saved Configurations, and the toolbar displays icons that you can use to change a defibrillator's settings.

Each area lists features that you can use in the workspace. For more information, see Using the workspace on page 28.

When you first start the software, the Navigation pane is open to the Getting Started workspace, and the Auto Hide button appears in the corner of the pane.

The Auto Hide button changes when clicked. Click the Auto Hide button once; the pane minimizes, and is replaced by a tab along the side of the workspace. To temporarily maximize the pane, hover the cursor over the tab. To restore the pane, click the tab; the pane expands and the Auto Hide button reappears.

You can drag the pane wider or narrower by hovering the cursor over the edge of the open pane until a double-headed arrow appears. With the double-headed arrow visible, click and drag the pane width.

The Help pane works in the same way as the Navigation pane, except the Help pane is minimized to a tab when you first open the software. Click the tab to open the Help pane.
Using the workspace

The workspace is the large area located to the right of the navigation pane. The information it displays depends on the navigation pane button you selected. Each navigation button opens a separate workspace: Getting Started, Configurations, or Administration.

Understanding the Getting Started workspace

When you start the software, HeartStart Configure displays the Getting Started workspace. This workspace provides basic information about using the HeartStart Configure software.

The Getting Started workspace displays the following resources:

- **2010 guidelines for Hands-only CPR.** You can click the Learn More link to get more details on how this change affects the configuration of your defibrillator, or you can click Update Now to go directly to the wizard to update your defibrillator to "hands-only CPR" settings.
  
  For more information about the Hands-only CPR Wizard, see the following topics:
  
  For HeartStart FRx, see Configuring HeartStart FRx AEDs for hands-only CPR on page 50.
  
  For HeartStart HS1, see Configuring 2005 and 2010 HeartStart HS1 AEDs for hands-only CPR on page 58.
  
- **Configurations** links to the Configuration screen, where you can begin reviewing and changing AED settings.
- **Review System Logs** displays the application log file, where all activity is recorded.
- **Select Accessories** helps you identify accessories that your defibrillator model requires to retrieve and send a configuration, such as secure digital (SD) card readers, Bluetooth adapters, and infrared (IrDa) adapters.
- **Check for Software Updates** displays any updates to HeartStart Configure that are available for download.

Understanding the Configurations workspace

In the Configurations workspace, you can decide how your defibrillator will operate during patient use.
In the navigation pane, click **Configurations** to open the Configurations workspace. Here you can do the following:

- Retrieve and view the current settings from your defibrillator
- Modify and save defibrillator configuration settings
- Set the clock or the language options (for the HeartStart FR3)
- Send the resulting configuration to your defibrillator
- Save your configuration for reuse later on other defibrillators
- Delete a previously saved configuration file
- Export a configuration so that other users can standardize how their defibrillators operate in an emergency
- Import a configuration created by a different user from another computer or file system

The Configurations workspace includes two panes on the left:

- Use **Configuration Tasks** to modify parameter settings or save a configuration for reuse later. You can also restore a defibrillator’s default settings.
- Use **Saved Configurations** to select a previously saved configuration from a list, open the configuration in the workspace to modify it, and then send it to a defibrillator.

On the right, you see links that provide information on some of the most common tasks in HeartStart Configure. Click any of the links to see more.

You can use configurations that were created on another user’s computer with HeartStart Configure, or Event Review 3.5. You can also export a configuration to another user’s computer. This allows other users of HeartStart Configure to update their defibrillators in a standardized way.

You can view information for your saved configurations. You can also sort and group configurations based on the following information types:

- Model
- Name
- Description
- Date modified
Understanding the Administration workspace

The Administration workspace contains the System Log. Use the System Log to view system activity recorded by the software or to conduct troubleshooting. For more information, see Working with the System Log on page 69.

HeartStart Configure records system activity and writes it to the System Log as messages. You can view a table of System Log messages. For more information, see System Log messages on page 115.

Customer support might ask you to mail the HeartStart Configure System Log information. To do this, on the Help menu, click Email logs to Customer Support.

Using Click Mode

To prevent the unintentional setting of selections, use Click Mode. This is the default selection mode for mouse operation. Click Mode means that you must first click a field to see the menu of available settings, and then click the menu list to select a setting. The menu list disappears when you click away from the field.

If you uncheck Click Mode (by clicking Tools and then Options), you can hover the cursor over a field to display the menu list (without needing to click), and then click an item in the list to change a setting.
Changing defibrillator settings

With Philips HeartStart Configure software, you can change how your defibrillator behaves in an emergency. You can create a configuration to change the behavior of a single defibrillator, or a fleet of defibrillators.

Changing a defibrillator’s configuration settings can change its behavior. Before modifying defibrillator configurations, refer to the device owner’s manual.

This section introduces common configuration tasks for the HeartStart FR3, HeartStart FRx, and HeartStart HS1 defibrillator models.

Common configuration tasks include the following:

- Retrieving and viewing a defibrillator’s configuration
- Modifying and saving a configuration
- Sending the configuration to your defibrillator

To ensure that your configuration changes have been correctly transmitted to the defibrillator, always retrieve and check the defibrillator configuration before using the defibrillator.

Restoring defaults

If you change your mind about any changes, you can always restore the defaults. Use the Restore Defaults command when you want to reset the configuration to the original factory settings.

The following are reasons to restore default settings:
You have modified settings in an open configuration, you don't like what you have done, and now you want to restart from factory settings.

You want to send the factory settings to the defibrillator.

To restore default configuration settings
1. Display the configuration in the Configurations workspace.
2. From the Edit menu or toolbar, click Restore Defaults.

Working with your defibrillator model

Information about your HeartStart defibrillator model is available here:

- See Working with HeartStart FR3 defibrillators on page 33.
- See Working with HeartStart FRx defibrillators on page 49.
- See Working with HeartStart HS1 defibrillators on page 57.
Working with HeartStart FR3 defibrillators

With the HeartStart FR3 defibrillator, you can retrieve and send a configuration using Bluetooth or a secure digital (SD) card. You can change the language settings using a secure digital (SD) card, or use an optional language card. When you change language settings, you can also enable the defibrillator to operate in bilingual mode. You can set the defibrillator time and date using Bluetooth wireless transmission.

The HeartStart FR3 displays information using an LCD screen.

Because many patient-care protocol parameters interact with each other, it is important to understand how each parameter setting affects the protocol. For more information, either see the FR3 Instructions for administrators guide or consult your medical director.

In the Configurations navigation pane, you can do any of the following:

- Click Configure an FR3 to create a new configuration. See Creating and saving configurations on page 65
- Click Set FR3 Clock to set the HeartStart FR3 date and time. See Setting the HeartStart FR3 clock on page 42
- Click Set Language Options to set your defibrillator primary language, or enable bilingual operation. See Setting the HeartStart FR3 language on page 44

Typical HeartStart FR3 configuration tasks

The following table lists tasks that you typically complete with a HeartStart FR3.
Preparing the HeartStart FR3 to transfer configurations

The HeartStart FR3 uses an optional Bluetooth transceiver or a secure digital (SD) card to send information between the defibrillator and computer.

You can use either Bluetooth or an SD card to transfer a configuration to your HeartStart FR3.

When you connect the HeartStart FR3 defibrillator to your computer running HeartStart Configure using Bluetooth, you can perform the following tasks:

- Retrieve and send a configuration
- Set the HeartStart FR3 date and time
If a HeartStart FR3 defibrillator is Bluetooth-enabled, **Wireless Data Transfer** will appear as a menu option when the HeartStart FR3 is in Administration mode. To enter Bluetooth mode, select that menu option. For more information on Bluetooth connections, see Using Bluetooth connections on page 36.

If you cannot access the Wireless Data Transfer mode, then you do not have the Bluetooth option. Instead, use a secure digital (SD) card to change HeartStart FR3 language settings. You must also use an SD language card to change HeartStart FR3 language settings. You can use a language card that comes with the HeartStart FR3 defibrillator or create one in HeartStart Configure. For more information, see Using an SD card to configure a HeartStart FR3 on page 37.

The HeartStart FR3 must be in Administration mode to perform the following tasks:

- Retrieve the current configuration from the HeartStart FR3 and bring it to your computer running HeartStart Configure
- Send a configuration to the HeartStart FR3 using either a Bluetooth connection or an SD data card
- Set the HeartStart FR3 date and time using Bluetooth

**To place a HeartStart FR3 defibrillator in Administration mode**

1. Unplug the pads connector.
2. Insert the HeartStart FR3 battery.
   The defibrillator sounds a beep, and the power light at the top is solid green. Wait until the green light begins periodically flashing.
3. Quickly press the green ON/OFF button, and wait for the voice prompts to instruct you to plug in pads connectors. **Disregard this prompt in this instance.**
   These voice prompts will stop once you place the defibrillator in Administration mode.
4. Press the green ON/OFF button again.
   The shutdown screen appears. Below the display, press and release the left soft key (soft key #1) to enter Administration mode.
5. The HeartStart FR3 enters Administration mode, and Administration appears on the LCD display screen.
   In Administration mode, you can take a variety of other actions. These are discussed in the following sections.
If you do not press the left soft key to enter Administration mode on the HeartStart FR3 shutdown screen, it will complete its normal shutdown sequence and enter standby mode. A flashing green light above the green ON/OFF button identifies the standby mode.

When the HeartStart FR3 is in administration mode and no action occurs for a period of ten minutes, the FR3 will time out.

**To exit Administration mode**

- To exit Administration mode, press the green ON/OFF button. Wait 10 seconds for the defibrillator to shut down.

**Using Bluetooth connections**

You can send information to and from the HeartStart FR3 using Bluetooth to your HeartStart FR3 only if you purchased the Bluetooth option.

To verify that you have a Bluetooth option installed, place the HeartStart FR3 defibrillator in Administration mode, and then select the **Wireless Data Transfer** option. If this option is not available, then you do not have a Bluetooth–equipped HeartStart FR3.

When you send a configuration or set the HeartStart FR3 clock, HeartStart Configure connects your computer to the HeartStart FR3 defibrillator using Bluetooth, and then allows you to transfer configuration information.

When you set up the Bluetooth software and adapter, ensure that the defibrillator and the computer that runs HeartStart Configure are within Bluetooth transmission range. The nominal Bluetooth transmission range between the computer and the defibrillator is 30 feet (10 meters).

In HeartStart Configure, the default Bluetooth wireless PIN four-digit number is 2071. If you want to implement your own security measures, for your future configuration changes and patient data downloading, you can change the PIN to a different number.

If you would like to purchase a Bluetooth card for your defibrillator, or a PC adapter, click Getting Started in the navigation pane, and then click the Select Accessories link.
Setting up the Bluetooth connections and adapters

In most cases, if you plug your Bluetooth adapter into your computer, your computer automatically installs the drivers needed for your adapter. If you need to install the adapter manually, however, follow the instructions that came with your Bluetooth adapter.

Using an SD card to configure a HeartStart FR3

You can use a secure digital (SD) card to retrieve the configuration from the HeartStart FR3 defibrillator, modify it in HeartStart Configure, save the settings to the SD card. Then use the card to send it to the HeartStart FR3 defibrillator.

You can also use a secure digital (SD) card to change the primary language and the bilingual options on the HeartStart FR3 defibrillator. (These language changes cannot be made using Bluetooth wireless transmission.) For more information, see Setting the HeartStart FR3 language on page 44.

To read an SD card, use your computer's card reader or plug an external card adapter into your computer. Any SD card adapter that Windows Explorer recognizes as a removable disk is acceptable.

Retrieving a HeartStart FR3 configuration

💡 Before you modify a HeartStart FR3 configuration, be aware of the current settings by reviewing the configuration.

You can use Bluetooth wireless transmission or a secure digital (SD) card to retrieve the configuration from the HeartStart FR3 and save it in HeartStart Configure. Before retrieving the configuration, ensure that your defibrillator and computer are set up to communicate using one of these methods. For more information, see Using Bluetooth connections on page 36.

To retrieve a HeartStart FR3 configuration using Bluetooth

1. Start HeartStart Configure on your computer and click the Configurations navigation button.

2. Place the HeartStart FR3 in Administration mode. For details, see Preparing the HeartStart FR3 to transfer configurations on page 34.
On the HeartStart FR3, use the left soft key (soft key #1) to navigate to **Wireless Data Transfer** mode, and then press the center soft key (soft key #2) to select this mode.

The screen message Ready for Data Transfer appears.

3. In HeartStart Configure, from the Configurations workspace, on the toolbar or on the **File** menu, click **Retrieve Configuration from AED or card**.

4. In the Welcome to the Configuration Retrieve Wizard window, click **Next**.

5. On the **Select Defibrillator** page, click the row with HeartStart FR3 from the list, and then click **Next**.

   The wizard instructs you to stand by while the configuration is transferred. The following columns appear:
   - Model: **FR3**
   - Serial number: for example, **C09B-00001**
   - Interface: **Bluetooth**

   The wizard displays a page indicating whether the configuration retrieve operation is successful or not.

6. Click **Finish**.

   The Configurations workspace displays the configuration fields.

**To retrieve a HeartStart FR3 configuration using an SD card**

1. Verify that there is an SD card in the HeartStart FR3. The slot is located inside the battery compartment.

2. Place the HeartStart FR3 in Administration mode. For more information, see [Preparing the HeartStart FR3 to transfer configurations](#) on page 34.

3. On the HeartStart FR3, use the left soft key (soft key #1) to navigate down the list. Using the center soft key (soft key #2), select Setup.

4. Using the left soft key (soft key #1), navigate down the list. Then, use the middle soft key (soft key #2) to select Save Setup to Data Card.

   A verification message, Saved to Card, appears.

5. To turn the defibrillator off, press the green **ON/OFF** button.

6. Remove the battery from the HeartStart FR3, and remove the SD card.

7. Insert the card into your computer's SD card reader or adapter.
8. In HeartStart Configure, click the **Configurations** navigation button.

The Configurations workspace opens.

9. From the toolbar or **File** menu, click **Retrieve configuration from AED or card**.

The Welcome to the Configuration Retrieve Wizard page appears.

10. Click **Next**.

The Select Defibrillator page appears, showing available SD card drives.

11. Click the drive with the SD data card, and then click **Next**.

The Retrieve Wizard indicates whether the configuration retrieve operation is successful or not.

12. Click **Finish**.

The retrieved configuration appears in the Configurations workspace.

---

**Modifying a HeartStart FR3 configuration**

Use the **Configurations** workspace to modify settings. Each field has a menu list that lists the allowed settings for that field.

---

Because many patient-care protocol parameters interact with each other, it is important to understand how each parameter setting affects the protocol. For more information, see the *Instructions for administrators guide* or consult your medical director.

---

HeartStart Configure provides tool tips with short descriptions of each configuration parameter. Hover the cursor over an information icon near the parameter to display the description.

---

To ensure that your configuration changes have been correctly transmitted to the defibrillator, always retrieve and check the defibrillator configuration before using the defibrillator.

---

Some settings are valid only on newer versions of the HeartStart FR3. If you attempt to apply newer parameters to an older defibrillator that does not support these parameters, then the parameter will be automatically reset to its default value. For more information, see the *HeartStart FR3 configuration parameters* on page 82.
Keep these two typographical conventions in mind when using the fields and menu list to select parameter settings:

- In fields, if the setting appears in regular black text, it is the default setting. If it appears in bold blue text, it is a nondefault setting. This helps make modified fields more obvious.
- In menu lists, the factory default settings are highlighted in bold text, and nondefault values are in regular black text.

HeartStart Configure also turns fields on and off based on other settings you select. If a field has gray wavy lines through it, it depends on another field and cannot be changed until that related field is modified.

**To modify a HeartStart FR3 configuration**

- You can set all fields to original factory default settings by clicking **Restore Defaults**.

1. Click the **Configurations** navigation button to display the Configurations workspace.

2. (Optional) If you did not retrieve the HeartStart FR3's current configuration, then in Configuration Tasks, click the **Configure an FR3** link to create a new configuration.

3. (Optional) Type a meaningful name and description in the **Configuration Name** and **Configuration Description** fields. The new information replaces the selection.

4. Click the parameter that you want to change. A menu list appears.

5. In the open menu list, click your preferred setting. For a complete list of all settings and their parameters and defaults, see [HeartStart FR3 configuration parameters on page 82](#).

6. (Optional) When you are satisfied with your changes, on the **File** menu or toolbar, click **Save configuration** to save it for future use.

**Sending a HeartStart FR3 configuration**

After you retrieve a configuration from the HeartStart FR3 and modify the configuration settings in the Configurations workspace, you can send the configuration to your HeartStart FR3 to modify how the defibrillator behaves in an emergency.
You can send the resulting configuration with Bluetooth wireless communication or an SD card, or use an SD card to transfer it.

To send a HeartStart FR3 defibrillator configuration using Bluetooth wireless communication

1. Start HeartStart Configure on your computer, and click the Configurations navigation button to display the Configurations workspace.
2. Place the HeartStart FR3 in Administration mode. For details, see Preparing the HeartStart FR3 to transfer configurations on page 34.
3. On the HeartStart FR3, use the left soft key (soft key #1) to navigate to Wireless Data Transfer mode, and then press the center soft key (soft key #2) to select the mode.
   The screen message Ready for Data Transfer appears.
4. On the File menu or on the toolbar, click Send configuration to AED or card 📄.
   The Welcome to the Configuration Send Wizard page appears.
5. Click Next.
6. On the Select Defibrillator Page, wait for the specific HeartStart FR3 you want to appear in the list.
7. Click the row with the correct defibrillator in it, and then click Next.
   A page appears instructing you to stand by while the configuration is sent.
   The Send Wizard displays a page indicating whether the configuration send operation is successful or not.
8. Click Finish.

To send a HeartStart FR3 configuration using an SD card

1. Start HeartStart Configure on your computer, and click the Configurations navigation button to display the Configurations workspace.
2. If you have not yet already done so, insert an SD card in your computer's SD card reader or adapter.
3. On the File menu or on the toolbar, click Send configuration to AED or card 📄.
   The Welcome to the Configuration Send Wizard page appears.
4. Click Next.
The Select Defibrillator page opens and displays removable drives, highlighting the drive with the SD card.

5. Click the drive with the SD data card, and then click **Next**.
A page appears instructing you to stand by while the configuration is sent. This page shows the model, serial number, and interface (connection) information. The Send Wizard displays a page indicating whether the send operation is successful or not.

6. Click **Finish**.

7. Remove the SD card from your computer's SD card reader or adapter.

8. Remove the HeartStart FR3 battery.

9. If there is an SD card in your HeartStart FR3, remove it. It is located inside the battery compartment.

10. Insert the SD card with your saved configuration in the HeartStart FR3 SD card slot.

11. Replace the HeartStart FR3 battery.
The defibrillator beeps once.

12. Press the green **ON/OFF** button to turn on the defibrillator.

13. Place the defibrillator in Administration mode. For more information, see **Preparing the HeartStart FR3 to transfer configurations** on page 34.

14. Press the left soft key (soft key #1) to use the Down arrow.

15. Press the middle soft key (soft key #2) to select Setup.

16. Press the left soft key (soft key #1) to navigate down the list to Load New Setup.

17. Press the middle soft key (soft key #2) to load the configuration.

### Setting the HeartStart FR3 clock

Use the **Set FR3 Clock** link in the left navigation pane, in the Configurations workspace, to synchronize the HeartStart FR3 date and time with that of your computer.

To change the clock using HeartStart Configure, the HeartStart FR3 must have the **Bluetooth** option.
You can also change the clock using the soft keys on the HeartStart FR3. See the *HeartStart FR3 instructions for administrators* for more information.

Philips recommends that you remove case data from the HeartStart FR3 defibrillator before you synchronize the date and time. This is to prevent time stamps in the patient data from inadvertently being changed. Use one of the Philips Event Review data management solutions first to download your patient event summary data.

The Set Clock Wizard consists of the following pages:

- A **Welcome** page where you can learn more about the wizard. You can choose to bypass this page in the future.

- A **Date and Time** page shows the computer's date and time. The software continues to update the time until it communicates with the defibrillator, at which point the defibrillator's date and time are adjusted. You can also use the control box to further adjust the time in minutes if you want to use a time that is different from that of your computer.

- An **Optional Settings** page where you can choose a previously saved configuration, to send to the defibrillator when the clock is set.

- A **Selection Page** displays information about the state of your defibrillator.

The following table describes the information shown in each field of the selection page:

<table>
<thead>
<tr>
<th>Data Column</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection State</td>
<td>Whether or not the defibrillator is ready. Possible values are:</td>
</tr>
<tr>
<td></td>
<td><strong>Ready</strong>: the defibrillator is compatible with the information being transferred.</td>
</tr>
<tr>
<td></td>
<td><strong>Offline</strong>: the defibrillator was found in a recent scan but is now not available for connection.</td>
</tr>
<tr>
<td></td>
<td><strong>Incompatible</strong>: the defibrillator cannot receive the information being transferred.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>The defibrillator's serial number found in the scan</td>
</tr>
<tr>
<td>Connection</td>
<td>The type of defibrillator transfer method used</td>
</tr>
<tr>
<td>Model</td>
<td>The defibrillator model</td>
</tr>
</tbody>
</table>
- A **Processing** page indicates that the computer and defibrillator are connecting.
- A **Status** page indicates either success or failure for the time-set operation.

**To synchronize the HeartStart FR3 clock**

1. Place the HeartStart FR3 in Administration mode.
   For details, see [Preparing the HeartStart FR3 to transfer configurations](#) on page 34.
2. In Philips HeartStart Configure, click **Configurations**.
3. Under **Configuration Tasks** in FR3 Configuration, click the **Set FR3 Clock** link to start the FR3 Set Clock wizard.

   To set the HeartStart FR3 to a time that is different than that of your computer, On the **Date and Time Page**, use the **Adjust in Minutes** control box. You can set the HeartStart FR3 defibrillator's time in minutes forward or backward relative to the computer's clock, up to a maximum of 1,440 minutes (24 hours).

   If you want to send a previously saved configuration to the HeartStart FR3 at the same time as the clock is set, on the **Optional Settings** page, click **Yes**, and then find the configuration in the **Choose a configuration that you have already saved** list.
4. Follow the on-screen instructions to transfer the time and date settings to the HeartStart FR3 defibrillator. If the transfer is successful, the HeartStart FR3 defibrillator displays the correct date and time.

**Setting the HeartStart FR3 language**

Using HeartStart Configure, you can change language settings for the locale in which you use the defibrillator. This includes the following:

- Changing the primary language
- Choosing an optional secondary language for bilingual operation

Language settings can be changed only by using an SD card; they cannot be changed using Bluetooth wireless transmission. Changing language features requires the HeartStart FR3 Language Pack. HeartStart Configure includes all the current released FR3 Language Packs. The FR3 Language Packs are also available separately.
You must use a secure digital (SD) card to save your language configuration and transfer it to a HeartStart FR3. For more information, see Using an SD card to configure a HeartStart FR3 on page 37.

The Set Language wizard consists of the following pages:

- A Welcome page. You can choose to bypass this page in the future.
- A Language Pack Location page. Choose from a list of available language packs.
- A Specify Language Package Options page. Choose a primary language for the HeartStart FR3 from a list of languages. You can also select a secondary language for bilingual operation.
- An Optional Settings page. Choose whether you want to create a configuration containing only your language choices, or to combine these language choices with an existing, general configuration.
- The Save Language Choices page. Choose the drive on which to save your language selections. The page displays information for the selected location, such as the volume name, the file system, free space available, and the total size of the file.
- A status page indicates whether you have successfully saved your language configuration or not.

**To set HeartStart FR3 language options**

1. On the HeartStart Configure navigation pane, click the **Configurations** navigation button to display the Configurations workspace.

2. On the navigation pane under **FR3 Configuration**, click **Set Language Options**.
   The Set Language Options Welcome to the FR3 Language Wizard page appears.

3. Click **Next**.

4. (Optional) Insert a language card into your computer's SD card reader or adapter.

5. On the Language Pack Location page, locate the language pack that you want to use.
   The Computer location contains the language pack installed with the HeartStart Configure software.

6. (Optional) If you are using the language card, locate the drive letter location, and then click the drive to open the language pack.
Inactive drives are indicated by gray text. The Language Packages field shows the name and description of the language pack.

7. Click **Expand** to display the available languages on the language pack.

   To verify if the language pack is compatible with your HeartStart FR3 version, click the **Information** icon to display a brief description of the language pack.

8. Click **Next**.

   The Specify Language Package Options page appears. At the top of the Language Options pane, the name of the language pack that you selected appears in the Language Pack field.

9. To select the primary language, click the **Primary Language** down arrow to open the list box, and then click a language from the list.

   You can click **Unchanged** to keep the current setting on the device.

10. (Optional) To set bilingual operation, click the **Enable Bilingual Operation** checkbox, click the down arrow to open the list box, and click a language from the list.

11. Click **Next**.

   The Optional Settings page appears. Here you have a choice: Do you want to send a configuration at the same time as you set the language options? If so, follow the next step. If not, skip the next step.

12. (Optional) To combine an existing configuration with the language settings, on the **Optional Settings** page, click **Yes**, and then find the configuration in the **Choose a configuration that you have already saved** list.

13. Click **Next**.

   The Save Language Choices page appears. Inactive drives are indicated by gray text. The Drive Details pane shows details of the drive you select: the Volume name, the File system, amount of Free space, and the Total size.

   You may be prompted to overwrite any existing configuration information on the target SD card.

14. Click **Next** to save your language configuration to the target SD card.

   The language configuration is saved, and the wizard displays a status page informing you whether the save was successful or not, and to what drive the configuration is saved.

15. Remove the card with your saved language configuration from your computer's SD card reader or adapter.
Loading new HeartStart FR3 primary and secondary languages

1. Remove the HeartStart FR3 battery, and then locate the card slot at the bottom of the battery compartment. If there is an SD data card in the slot, first remove it.

2. Insert the card with the saved language configuration in the card slot.

3. Reinstall the battery while holding down the right soft key (soft key #3). Keep the soft key pressed until the blank screen with the speaker icon displays.

   The HeartStart FR3 display screen displays green progress bars as the languages load.

4. The new language file automatically loads. The HeartStart FR3 displays the language name and a progress bar. During language installation, the HeartStart FR3 cannot be turned off.

   If the new language installation does not complete, the HeartStart FR3 reverts to the default primary language and displays a setup error screen.

5. When the language load is complete, the HeartStart FR3 displays the following screen messages: Setup Complete and Remove Language Card. If an error occurs during loading, the HeartStart FR3 displays a Setup Error message in the default language.

6. Remove the card from the HeartStart FR3, and insert the battery.

   The HeartStart FR3 performs a user-initiated test (UIT).

To enable bilingual operation on the HeartStart FR3

1. Press the green ON/OFF button. The defibrillator beeps once.

   The HeartStart FR3 prompts you with a voice message to select either the primary language (left soft key, or soft key #1) or the secondary language (right soft key, or soft key #3). The language selections display on the tabs at the bottom of the HeartStart FR3 LCD screen.

2. Select the secondary language by selecting the right soft key (soft key #3).

   If you do not select the secondary language within 10 seconds, the HeartStart FR3 continues to operate in the primary language.
The HeartStart FR3 announces the language selection and uses that language for all operation, until the HeartStart FR3 returns to standby mode.

You must select either the primary or the secondary language each time you turn on the HeartStart FR3 for use.
Working with HeartStart FRx defibrillators

There are different types of HeartStart FRx defibrillators. Newer models have a label that reads either 2005 GUIDELINES or 2010 GUIDELINES on the back of the device, and follow 2005 and 2010 guidelines. If your HeartStart FRx does not have one of these labels, then it is programmed for 2000 guidelines.

If you attempt to update a HeartStart FRx using the configuration of the wrong guideline for that device, HeartStart Configure indicates that the configuration is incompatible with that model of HeartStart FRx.

Typical HeartStart FRx configuration tasks

The following table lists tasks that you typically complete with a HeartStart FRx.

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing your HeartStart FRx to send a configuration using an infrared connection</td>
<td>See the appropriate topic for the FRx defibrillator model:</td>
</tr>
<tr>
<td></td>
<td>Preparing the HeartStart FRx to transfer configurations on page 51.</td>
</tr>
<tr>
<td></td>
<td>Setting up infrared connections and adapters on page 58.</td>
</tr>
<tr>
<td>Retrieving a configuration</td>
<td>See Retrieving a HeartStart FRx configuration on page 52.</td>
</tr>
<tr>
<td>Modifying default parameter settings</td>
<td>See Modifying a HeartStart FRx configuration on page 53.</td>
</tr>
<tr>
<td>Sending a configuration</td>
<td>See Sending a HeartStart FRx configuration on page 55.</td>
</tr>
</tbody>
</table>
Configuring HeartStart FRx AEDs for hands-only CPR

You can update your HeartStart FRx AEDs to support hands-only CPR.

Hands-only CPR means that the AED will not prompt the user to give rescue breaths as part of the CPR procedure. 2010 Guidelines recommend hands-only CPR for users who are untrained or unable to perform rescue breaths.

This topic explains how to use the Hands-only CPR Wizard to automatically configure the hands-only CPR settings on your defibrillators.

To change configuration settings manually, see HeartStart FRx 2005 and 2010 guidelines configuration parameters on page 92.

There are several ways to open the Hands-only CPR wizard.

To open the Hands-only CPR Wizard directly
- To begin configuring HeartStart FRx for hands-only CPR without first opening the HeartStart Configure application, you can click the Hands-only CPR Wizard from the Philips HeartStart 3.1 menu in the Windows All Programs menu.

To learn more about hands-only CPR and then open the Hands-only CPR Wizard
- If you want to learn more about hands-only CPR before configuring your HeartStart AEDs, in the Getting Started workspace, click the Learn More link to open an educational screen, Learn About Hands-only CPR. From that screen, you can click the Update Now link to open the wizard and start the configuration process.

To open the Hands-only CPR Wizard from within the HeartStart Configure application
- In the Getting Started workspace, click the Update Now link.

The Hands-only CPR wizard opens. The wizard contains all of the instructions you need to configure your AED for Hands-only CPR.
Setting up infrared connections and adapters

HeartStart Configure communicates with your HeartStart defibrillator over an infrared connection.

On an initial installation of your infrared adapter, if the drivers do not install automatically, then insert the CD-ROM that came with your infrared adapter and use the New Hardware Wizard on your computer to set up the adapter.

You can use most USB infrared adapters to transfer a configuration between a computer running Philips HeartStart Configure and a defibrillator that uses infrared as the transfer method. Philips offers an infrared adapter, product number ACT-IR, that you can use for this purpose.

Use the default device drivers for the adapter. For best results, plug the hardware adapter into the USB port and use the default Windows driver.

Philips HeartStart Configure recognizes when an infrared adapter is plugged into the computer and is available. You do not have to perform any additional steps.

Position the computer and the defibrillator for infrared transfer.

Preparing the HeartStart FRx to transfer configurations

To transfer a configuration to the HeartStart FRx, you must first place the defibrillator in Administration mode. The defibrillator must be turned on, and the pads connector must not be in place.

The HeartStart FRx uses infrared (IrDA) to communicate with your computer. Philips recommends that you start HeartStart Configure before placing HeartStart FRx in Administration mode.

In order to transfer a configuration, your computer IrDA window or adapter and the defibrillator IrDA window must face one another. For more information, see Setting up infrared connections and adapters on page 58.
Administration mode times out after three minutes for a first-time connection between a HeartStart FRx defibrillator and computer. 

Once the software connects to the defibrillator, the timeout is 30 minutes from the last connection. Each time a configuration is sent, the timeout resets.

To place a HeartStart FRx defibrillator in Administration mode

1. Remove the pads connector.
2. If you haven't done so already, insert the battery into the defibrillator.
   You will hear voice prompts to plug in pads connectors. **Disregard these prompts in this instance.** These messages end once you place the defibrillator in Administration mode.
3. Press the green **ON/OFF** button.
4. On the defibrillator, press and hold the blue **Information** button, and wait for three tones.
5. Release the blue Information button.
   The voice message announces Administration. The defibrillator enters data transfer mode, and you can now configure your defibrillator.
6. Position the defibrillator to communicate with the computer. The computer running HeartStart Configure and defibrillator should be approximately 12 inches (30 cm) apart.

To exit Administration mode

1. Press the green **ON/OFF** button.
2. Plug in the pads connector.
   The defibrillator is now ready for use on a patient.

**Retrieving a HeartStart FRx configuration**

Before changing your HeartStart FRx configuration settings, you may want to first view the current settings. You can use Infrared (IrDA) to retrieve a configuration from the HeartStart FRx and view it in HeartStart Configure. For more information on setting up a IrDA connection, see Setting up infrared connections and adapters on page 58.
To retrieve a HeartStart FRx configuration

1. Position the computer IrDA window or attached IrDA adapter and the HeartStart FRx defibrillator IrDA window so that they face each other. The computer running HeartStart Configure and defibrillator should be approximately 12 inches (30 cm) apart.

2. In Philips HeartStart Configure, click the Configurations navigation button to display the Configurations workspace.

3. Place the HeartStart FRx in Administration mode. For more information, see Preparing the HeartStart FRx to transfer configurations on page 51.

4. On the toolbar or on the File menu, click Retrieve configuration from AED or card.
   The Welcome to the Configuration Retrieve Wizard window appears.

5. Click Next.

6. On the Select Defibrillator page, click the row with the HeartStart FRx link in it, and then click Next.
   A page appears while the configuration is sent from the defibrillator. This page shows the model, serial number, and interface (connection) information. The HeartStart FRx defibrillator voice message announces Transferring data to indicate that the computer is receiving information from the defibrillator.

7. Wait for the HeartStart FRx to sound three confirmation tones.
   The wizard displays a page indicating whether the configuration retrieve operation is successful or not.

8. Click Finish.
   The retrieved configuration appears in the Configurations workspace, and you can now view and modify the configuration.

Modifying a HeartStart FRx configuration

Use the Configurations workspace to modify a configuration file's settings. Each field has a menu list that lists the allowed settings for that field.

Because many patient-care protocol parameters interact with each other, it is important to understand how each parameter setting affects the protocol. For more information, see the HeartStart FRx owner's manual or consult your medical director.
HeartStart Configure provides tool tips with short descriptions of each configuration parameter. Hover the cursor over an information icon near the parameter to display the description.

Keep these two typographical conventions in mind when using the fields and menu list to select parameter settings:

- In fields, if the setting appears in regular black text, it is the default setting. If it appears in bold blue text, it is a nondefault setting. This helps make modified fields more obvious.
- In menu lists, the factory default settings are highlighted in bold text, and nondefault values are in regular black text.

HeartStart Configure also turns fields on and off based on other settings you select. If a field has gray wavy lines through it, it depends on another field and cannot be changed until that related field is modified.

**To modify a HeartStart FRx configuration**

You can set all fields to original factory default settings by clicking **Restore Defaults**.

1. Click the **Configurations** navigation button to display the Configurations workspace.
2. (Optional) If you did not retrieve your HeartStart FRx's current configuration, then in Configuration Tasks, click **Configure an FRx (Guidelines 2005/2010)**, or **Configure an FRx (Guidelines 2000)** to create a new configuration.
3. (Optional) Type a meaningful name and description in the **Configuration Name** and **Configuration Description** fields. The new information replaces the selection.
4. Click the parameter that you want to change. A menu list appears.
5. In the open menu list, click the setting that you want.

For a complete list of parameters, including defaults:

- See **HeartStart FRx 2000 guideline configuration parameters on page 98**
- See **HeartStart FRx 2005 and 2010 guidelines configuration parameters on page 92**

---

6 - Changing defibrillator settings
6. (Optional) When you are satisfied with your changes, on the **File** menu or toolbar, click **Save configuration** to save the configuration for future use.

### Sending a HeartStart FRx configuration

After you modify the settings in the HeartStart FRx configuration, you can use infrared (IrDA) to send this configuration to the HeartStart FRx, to change how the defibrillator behaves in an emergency. For more information, see [Setting up infrared connections and adapters](#) on page 58.

You can also create a new configuration to send to the HeartStart FRx. For more information, see [Creating and saving configurations](#) on page 65.

#### To send a configuration to a HeartStart FRx

1. Click the **Configurations** navigation button to display the Configurations workspace.

2. Position the computer IrDA window or attached IrDA adapter and the HeartStart FRx defibrillator infrared transport window so that they face each other. The computer running HeartStart Configure and defibrillator should be approximately 12 inches (30 cm) apart.

3. Place the HeartStart FRx in Administration mode. For more information, see [Preparing the HeartStart FRx to transfer configurations](#) on page 51.

4. On the toolbar or on the **File** menu, click **Send configuration to AED or card**.

   The Welcome to the Configuration Send Wizard window appears.

5. Click **Next**.

6. On the **Select Defibrillator** page, click the row with the HeartStart FRx link in it, and then click **Next**.

   A standby page appears when the configuration is sent to the defibrillator. This page shows the model, serial number, and interface (connection) information. The HeartStart FRx voice message announces Transferring data, indicating that the defibrillator is receiving the configuration from the computer.

7. Wait for the HeartStart FRx to sound three confirmation tones.
6 - Changing defibrillator settings

The Send wizard displays a page indicating whether the configuration send operation is successful or not.

8. Click **Finish**.
Working with HeartStart HS1 defibrillators

There are different types of HeartStart HS1 defibrillators. Newer models have a label that reads either 2005 GUIDELINES or 2010 GUIDELINES on the back of the device, and follow 2005 and 2010 guidelines. If your HeartStart HS1 does not have one of these labels, then it is programmed for 2000 guidelines.

If you attempt to update a HeartStart HS1 using the configuration of the wrong guideline for that device, HeartStart Configure indicates that the configuration is incompatible with that model of HeartStart HS1.

Typical HeartStart HS1 configuration tasks

The following table lists tasks that you typically complete with a HeartStart HS1.

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing the HeartStart HS1 to transfer a configuration using infrared connections</td>
<td>See the appropriate topic for the HS1 defibrillator model:</td>
</tr>
<tr>
<td></td>
<td>Preparing the HeartStart HS1 to transfer configurations on page 59.</td>
</tr>
<tr>
<td></td>
<td>Setting up infrared connections and adapters on page 58.</td>
</tr>
<tr>
<td>Retrieving a configuration</td>
<td>See Retrieving a HeartStart HS1 configuration on page 61.</td>
</tr>
<tr>
<td>Modifying and saving a configuration</td>
<td>See Modifying a HeartStart HS1 configuration on page 62.</td>
</tr>
<tr>
<td>Sending a configuration</td>
<td>See Sending a HeartStart HS1 configuration on page 63.</td>
</tr>
</tbody>
</table>
Configuring 2005 and 2010 HeartStart HS1 AEDs for hands-only CPR

You can update your HeartStart HS1 (2005 and 2010 releases) AED to support hands-only CPR.

Hands-only CPR means that the AED will not prompt the user to give rescue breaths as part of the CPR procedure. 2010 Guidelines recommend hands-only CPR for users who are untrained or unable to perform rescue breaths.

To change configuration settings manually, see HeartStart HS1 2005 and 2010 guidelines configuration parameters on page 104.

There are several ways to open the Hands-only CPR wizard.

To open the Hands-only CPR Wizard directly

- To begin configuring HeartStart FRx for hands-only CPR without first opening the HeartStart Configure application, you can click the Hands-only CPR Wizard from the Philips HeartStart 3.1 menu in the Windows All Programs menu.

To learn more about hands-only CPR and then open the Hands-only CPR Wizard

- If you want to learn more about hands-only CPR before configuring your HeartStart AEDs, in the Getting Started workspace, click the Learn More link to open an educational screen, Learn About Hands-only CPR. From that screen, you can click the Update Now link to open the wizard and start the configuration process.

To open the Hands-only CPR Wizard from within the HeartStart Configure application

- In the Getting Started workspace, click the Update Now link.

  The Hands-only CPR wizard opens. The wizard contains all of the instructions you need to configure your AED for Hands-only CPR.

Setting up infrared connections and adapters

HeartStart Configure communicates with your HeartStart defibrillator over an infrared connection.
On an initial installation of your infrared adapter, if the drivers do not install automatically, then insert the CD-ROM that came with your infrared adapter and use the New Hardware Wizard on your computer to set up the adapter.

You can use most USB infrared adapters to transfer a configuration between a computer running Philips HeartStart Configure and a defibrillator that uses infrared as the transfer method. Philips offers an infrared adapter, product number ACT-IR, that you can use for this purpose.

Use the default device drivers for the adapter. For best results, plug the hardware adapter into the USB port and use the default Windows driver.

Philips HeartStart Configure recognizes when an infrared adapter is plugged into the computer and is available. You do not have to perform any additional steps.

Position the computer and the defibrillator for infrared transfer.

Preparing the HeartStart HS1 to transfer configurations

To transfer a configuration to the HeartStart HS1, you must first place the defibrillator in Administration mode. The defibrillator must be turned on, with the pads cartridge removed.

The HeartStart HS1 uses infrared (IrDA) to communicate with your computer. Philips recommends that you start HeartStart Configure and prepare the IrDA connection before placing the HeartStart HS1 in Administration mode.

In order to transfer a configuration, your computer IrDA window or adapter and the defibrillator IrDA window must face one another. For more information, see Setting up infrared connections and adapters on page 58.
The Administration mode for a HeartStart HS1 (for the initial connection to the computer running HeartStart Configure) times out after 30 seconds for earlier models (those without the 2005 Guidelines or 2010 Guidelines label), and three minutes for later models (those with the 2005 Guidelines or 2010 Guidelines label). Once the software connects to the defibrillator, the timeout is 30 minutes from the last connection. Each time a configuration is sent, the timeout resets.

To place a HeartStart HS1 defibrillator in Administration mode

1. Remove the pads cartridge. Locate the latch at the top, and then slide the latch to the right to release the pads cartridge.
2. If you haven't done so already, insert the battery into the defibrillator.
   
   You will hear voice prompts to plug in the pads cartridge. **Disregard these prompts in this instance.** These messages will be silenced once you place your defibrillator in Administration mode. After the battery is inserted, the defibrillator automatically turns on.
3. On the defibrillator, press and hold the blue **Information** button, and then wait for three tones.
4. Release the blue button.
   
   A voice message announces Administration.
5. Briefly press the blue **Information** button again.
   
   The voice message says Mode 1.
6. Position the defibrillator to communicate with the computer. The computer running HeartStart Configure and defibrillator should be approximately 12 inches (30 cm) apart.

   If you want to retrieve a HeartStart HS1 configuration, see **Retrieving a HeartStart HS1 configuration on page 61.**

   If you want to send a HeartStart HS1 configuration, see **Sending a HeartStart HS1 configuration on page 63.**

To exit Administration mode

1. To exit Administration mode, press the green power button.
2. After you transfer the configuration, plug in the pads cartridge.
   
   The defibrillator is now ready for use on a patient.
Retrieving a HeartStart HS1 configuration

Before changing your HeartStart HS1 configuration settings, you may want to first view the current settings. You can use Infrared (IrDA) to retrieve a configuration from the HeartStart HS1 and save it in HeartStart Configure. For more information on setting up a IrDA connection, see Setting up infrared connections and adapters on page 58.

To retrieve a HeartStart HS1 configuration

1. Position the computer IrDA window or attached IrDA adapter and the HeartStart HS1 defibrillator IrDA window so that they face each other. The computer running HeartStart Configure and defibrillator should be approximately 12 inches (30 cm) apart.

2. In Philips HeartStart Configure, click Configurations to open the Configurations workspace.

3. Place the HeartStart HS1 in Administration mode. For more information, see Preparing the HeartStart HS1 to transfer configurations on page 59.

4. From the File menu, click Retrieve configuration from AED or card 📄. The Welcome to the Configuration Retrieve Wizard window appears.

5. Click Next.

6. On the Select Defibrillator page, click the row with the HeartStart HS1 link in it, and then click Next. A standby page appears while the configuration is sent from the defibrillator. This page shows the model, serial number, and interface (connection) information. The HeartStart HS1 defibrillator voice message announces Sending, indicating that the computer is receiving information from the defibrillator.

7. Wait for the HeartStart HS1 to sound three confirmation tones. The Retrieve Wizard displays a page indicating whether the configuration retrieve operation is successful or not.

8. Click Finish.

The retrieved configuration appears in the Configurations workspace, and you can now view and modify the configuration.
Modifying a HeartStart HS1 configuration

Use the Configurations workspace to modify a configuration file's settings. Each field has a menu list that lists the allowed settings for that field.

Because many patient care protocol parameters interact with each other, it is important to understand how each parameter setting affects the protocol. For more information, see the HeartStart HS1 owner's manual or consult your medical director.

HeartStart Configure provides tool tips with short descriptions of each configuration parameter. Hover the cursor over an information icon near the parameter to display the description.

Keep these two typographical conventions in mind when using the fields and menu list to select parameter settings:

- In fields, if the setting appears in regular black text, it is the default setting. If it appears in bold blue text, it is a nondefault setting. This helps make modified fields more obvious.
- In menu lists, the factory default settings are highlighted in bold text, and nondefault values are in regular black text.

HeartStart Configure also turns fields on and off based on other settings you select. A field with gray wavy lines depends on another field and cannot be changed until that related field is modified.

To modify a HeartStart HS1 configuration

You can set all fields to original factory default settings by clicking Restore Defaults.

1. Click the Configurations navigation button to display the Configurations workspace.
2. (Optional) If you did not retrieve your HeartStart HS1’s current configuration, then in Configuration Tasks, click Configure an HS1 (2005/2010 Guidelines), or Configure an HS1 (Guidelines 2000) to create a new configuration.
3. (Optional) Type a meaningful name and description in the Configuration Name and Configuration Description fields.
   - The new information replaces the selection.
4. Click the parameter that you want to change.
A menu list appears.

5. In the open menu list, click a setting. For a complete list of all parameters, including default settings, see HeartStart HS1 2000 guidelines configuration parameters on page 110 or Preparing the HeartStart HS1 to transfer configurations on page 59.

6. (Optional) When you are satisfied with your changes, on the File menu or toolbar, click Save configuration to save the configuration for future use.

Sending a HeartStart HS1 configuration

After you modify the settings in the HeartStart HS1 configuration, you can use infrared (IrDA) to send the configuration to the HeartStart HS1, to change how the defibrillator behaves in an emergency. For more information, see Setting up infrared connections and adapters on page 58.

You can create a new configuration to send to the HeartStart HS1. For more information, see Creating and saving configurations on page 65.

To send a HeartStart HS1 configuration

1. Click the Configurations navigation button to display the Configurations workspace.

2. Position the computer infrared transport window or attached IrDA adapter and the HeartStart HS1 defibrillator infrared transport window so that they face each other. The computer running HeartStart Configure and defibrillator should be approximately 12 inches (30 cm) apart.

3. Place the HeartStart HS1 in Administration mode. For more information, see Preparing the HeartStart HS1 to transfer configurations on page 59.

4. On the toolbar or on the File menu, click Send configuration to AED or card.

   The Welcome to the Configuration Send Wizard window appears.

5. Click Next.

6. On the Select Defibrillator page, click the row with the HeartStart HS1 defibrillator link in it, and then click Next.
A standby page appears while the configuration is sent to the defibrillator. This page shows the model, serial number, and interface (connection) information. The HeartStart HS1 voice message announces Sending, indicating that the defibrillator is receiving the configuration from the computer.

7. Wait for the HeartStart HS1 to sound three confirmation tones.
   The Send Wizard displays a page indicating whether the configuration send operation is successful or not.

8. Click **Finish**.
Working with saved configurations

On the Configurations pane, you can access various defibrillator configuration tasks.

- Creating and saving configurations (see Creating and saving configurations on page 65)
- Opening previously saved configurations (see Opening previously saved configurations on page 66)
- Exporting configuration files to colleagues who are also running HeartStart Configure on their computers (see Exporting a configuration file on page 67)
- Importing configuration files from a colleague (see Importing a configuration file on page 67)
- Deleting configurations (see Deleting configurations on page 68)

For security purposes, configuration files created by one user are not visible to other users on the same machine.

Creating and saving configurations

When you are creating a configuration, the workspace displays the default parameter settings. Once you modify the configuration, you can do any of the following:

- Send it to a defibrillator
- Save it on your computer for later use
- Export it for use by a colleague on another computer running HeartStart Configure

To create and name a new configuration

1. Click the Configurations navigation button.
The Configurations navigation pane displays panes and links for the supported defibrillators.

2. Use one of the following methods to create a configuration:
   - In the **Configuration Tasks** navigation pane, click the defibrillator and the guidelines link for your defibrillator model.
   - On the **File** menu or toolbar, click **New Configuration**. Click a defibrillator and the guidelines link for the defibrillator model.

   HeartStart Configure opens a new configuration for the defibrillator type.

3. In the **Configuration Name** field, type a name for your configuration. You can change the software-generated configuration name to a different name.

4. In the **Configuration Description** field, type the description for your configuration.

5. In the **User Name** field, type your name.

6. On the **File** menu or toolbar, click **Save configuration** to save your new configuration.

---

**Opening previously saved configurations**

You can open a previously saved configuration in the **Configurations** workspace using the **Saved Configurations** list.

**To open a previously saved configuration in the Configurations workspace**

1. Click the **Configurations** navigation button.

   The Configurations workspace appears.

2. Choose between these two methods to open your saved configuration.
   - In the Navigation pane, click the **All Configurations** link, click a configuration, and then double-click it to open it in the workspace. Or, you can click the configuration in the All Configurations list, and then from the File menu or toolbar, click **File**, and then click **Open configuration**.
To open a configuration for a particular defibrillator model, click the defibrillator model link in the **Saved Configurations** pane (for example, **FRx Configurations**), and then double-click the desired configuration, or (from the File menu or toolbar) click **Open configuration**.

### Exporting a configuration file

You can export a configuration file that you created in the **Configurations** workspace to another computer that runs HeartStart Configure.

Here are a few reasons to export a configuration file to another computer:

- You want to give a configuration file you created to your colleagues so that they can standardize their defibrillator settings.
- You want to export your saved configurations for safekeeping.

**To export a file**

1. Click the **Configurations** button to open the Configurations workspace.
2. In the navigation pane on the Saved Configurations pane, click **All Configurations**.
3. Click the configuration to export.
4. From the **File** menu or toolbar, click **Export**. The Export File As window shows the last folder you used to export a file.
   - To use a different location, navigate to the directory of your choice.
5. (Optional) Rename the file, and then click **Save**.
   - The configuration file is exported to the selected folder.

### Importing a configuration file

You can import a configuration file that was created on a colleague’s computer into the **Configurations** workspace if the configuration file is located in a folder accessible from your computer.
After you import a file, HeartStart Configure displays the configuration file in the Configurations workspace. You can then view it, modify it, and use it to update the settings on your defibrillators.

**To import a file**

1. Click the **Configurations** navigation button.
2. On the File menu or toolbar, click **File**, and then click **Import configuration from folder**.
   
   The Import File window appears, displaying the last folder that you used to import a file. If the file is in a different location, click the appropriate folder in the Import File window to navigate to the file location. The default import folder is located in the My Documents folder.
3. Click the **File of Type** down arrow to select either an XML file, or a DAT file.
   
   XML files are exported by HeartStart Configure 3.0 or later. DAT files are exported by Event Review Pro/Event Review 3.5.
4. Click the configuration file, and then click **Open**.
   
   The imported configuration file appears.

---

**Deleting configurations**

You can delete a configuration only from the **Configurations** workspace. If you want to export a configuration before deleting it, see **Exporting a configuration file on page 67**.

> ! Once you delete a configuration, you cannot restore it or undo your delete. All of the configuration information will be lost.

**To delete a configuration**

1. Click the **Configurations** navigation button to display the Configurations navigation pane and workspace.
2. Click **All Configurations** to display a list of configurations in the Configurations workspace.
3. Click the configuration that you want to delete.
4. On the File menu or toolbar, click **Delete**.
5. At the prompt, click **Yes**.
Working with the System Log

The System Log displays HeartStart Configure activity. In the navigation pane, click Administration to access the System Log.

Three information types are available in the System Log: Information, Error, and Warning messages.

- An Information message summarizes end-user actions. For example, a message stating "Opened the application" is created when you open Philips HeartStart Configure.

- An Error message specifies what an error is or why it occurred. For example, if there is a failure to import a file, an error message states "Failed to import file" and includes the file path in parentheses. For a table of system messages, see System Log messages on page 115.

- A Warning message is logged in some instances, such as when the user has suppressed the general warning message that appears when HeartStart Configure starts.

You can email the HeartStart Configure System Log information to Philips Customer Support when you are asked to do so.

- On the Help menu, click Email logs to Customer Support.

Opening the System Log

The System Log is available from the Administration navigation pane. On the navigation pane, click Administration to open the System Log. HeartStart Configure displays the System Log workspace.
Viewing the System Log

The System Log displays the status of all Philips HeartStart Configure activity. It also contains all messages that are generated by HeartStart Configure about actions and events in the software.

You can view the following System Log columns in the System Log workspace. An asterisk (*) represents default columns.

- Type*
- Date and Time*
- Action*
- Description*
- User Name* (This is the name of the user who is currently logged in, not the name that appears in the Name field in the Configurations workspace.)
- Computer
- Serial Number
- Configuration Name
- Model
- Transfer Method

To view additional columns, right-click the column header, and click the column that you want to appear.

You can sort, group, and customize columns in the System Log just as you can in the Configurations and Administration workspaces. For more information, see Displaying information in tables on page 71.

For a list of the types of System Log messages, see System Log messages on page 115.

For each action in the System Log, the software includes the following information:

- The type of activity; for example, Information or Error
- The action that occurred
- A description of the action
- The date and time when the action occurred
Displaying information in tables

The System Log messages are presented in a table. In tables, you can categorize, sort, and group the information by column headers (for example, by Description). Sorting helps you manage large amounts of information, and lets you easily navigate to a single item in an information group.

You can also use these methods with other tables, for example, in the Configurations workspace, with tables of configurations.

Working with columns

You can customize the columns that appear on the table.

To change or size a column width
• Click and hold the column border, and then drag the border to the size you prefer.

To reset a column to its previous width
• Click the column border, and then double-click the border.

To hide or display a column
1. Right-click the column header name to display a shortcut menu.
   A popup menu appears.
2. Click a checkbox for each column that you want to hide or display on the table.
   Column headers with a check mark appear on the table.

To move a column
• Click and hold the column header, and then drag it left or right to a new location.

Sorting information in columns

You can sort information in columns by clicking the column header. A triangular symbol (arrow) in the column header indicates the sort order, ascending or descending.
To sort column entries

- Click the column header to sort the list of information in ascending (1 to 9, or a to z) or descending (9 to 1, or z to a) order.

You can also add columns to a sort.

To add columns to a sort

- Click a column heading to begin your sort, and then hold the SHIFT key while clicking additional column headings.
  
  For example, in the Administration workspace, in the system log, click the Descriptions column heading, and then hold the SHIFT key while clicking the Date and Time column heading. The rows are sorted by description, and then by date and time.
  
  The sort is ended, and a new sort is begun, when you click a column heading without holding the SHIFT key.

Grouping information in columns

In the gray area above information such as configurations or System Log messages, you can set up groups using table column headers. Setting up groups has the effect of sorting the information into major and minor sorts. For example, you can group information in the System Log using the column, Type. This creates an additional sort of the table according to the values in the Type column: Information and Error. If you want to create further minor sorts, you can then drag more column headings into the gray area to create subgroups.

You can also hide or display (collapse or expand) the grouped information.

To group information

1. Click a column header and drag it to the grouping area labeled Drag a Header Here to Group by that Column.
   
   The column name moves to the grouping area, and the table displays the groups you create.

2. Repeat step 1 as necessary to create more groups.
   
   The next group level appears.

💡 Click the column header to sort the order in which the grouped information appears.
To hide or display information groups

1. Locate the group of rows to collapse.
2. Click the **Collapse** button to the left of the group to collapse it, or click the **Expand** button to the left of the group to expand it.
   - If you want to hide multiple information groups, on the View menu or toolbar, click **Collapse All**.
   - If you want to display multiple information groups, on the View menu or toolbar, click **Expand All**.

To ungroup information

- Click a column header (for example, **Type**) in the grouping area and drag it below the table header.
[This page intentionally left blank]
Confirmation Messages

When you make a change, a confirmation message can appear to do one of two things:

- Inform you that an action might result in a change to a configuration
- Warn you that an action may cause a permanent change

By default, confirmation messages are enabled.

**To disable confirmation messages**
- When a confirmation message appears, click the *Do not show this message again* checkbox.

**To restore confirmation messages**
- On the *Tools* menu, click *Options*, and then click *Restore Confirmations*. 
Contacting Customer Support

Philips strives to provide you with excellent customer service and technical support. Software updates are available from the Help menu. From the Help menu, click **Check for Updates**.

You can contact Customer Support through email, the Internet, telephone, and mailing address, or via the Getting Started page.

- Send email to hsconfigure.support@philips.com
- Visit the Philips Healthcare product support Web site at:

  http://www.philips.com/DataManagementSupport

  To view the Philips Healthcare Product support Web site better in the online help pane, double-click the top of the help window to expand the pane.

For telephone assistance outside the United States, please call your sales representative or local sales office. Use the technical support telephone numbers for data management products on the product support Web site.

For telephone support in English only, call the following numbers between 8:00 AM and 4:00 PM, Pacific Time:

- (800) 263.3342, inside the United States
- +1(425) 908.2799, outside the United States
## Getting help

Customer Support can assist you in resolving issues with HeartStart Configure software.

You can also email the HeartStart Configure System Log information to Customer Support when you are asked to do so. On the Help menu, click **Email logs Customer Support**.

Customer Support technicians provide help for the following:

<table>
<thead>
<tr>
<th>Region</th>
<th>Address</th>
<th>Telephone number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>United States</strong></td>
<td>Philips Medical Systems&lt;br&gt;22100 Bothell Everett Highway&lt;br&gt;Bothell, WA&lt;br&gt;98021-8431, USA</td>
<td>(800) 263.3342&lt;br&gt;+1(425) 908.2799</td>
</tr>
<tr>
<td><strong>Canada</strong></td>
<td>Philips Medical Systems, a division of Philips Electronics Ltd.&lt;br&gt;281 Hillmount Road&lt;br&gt;Markham, Ontario,&lt;br&gt;L6C 2S3 Canada</td>
<td>(800) 291.6743</td>
</tr>
<tr>
<td><strong>Europe, Middle East, and Africa</strong></td>
<td>Philips Medizinsysteme Boeblingen GmbH, Cardiac and Monitoring Systems&lt;br&gt;Hewlett-Packard Strasse 2&lt;br&gt;71034 Boeblingen, Germany</td>
<td>(+49) 7031 463-2254</td>
</tr>
<tr>
<td><strong>Latin America</strong></td>
<td>Philips Medical Systems Ltda.&lt;br&gt;Av. Dr. Marcos Penteado Ulhôa Rodrigues, 401&lt;br&gt;Parte 16 – 06460-040 – Barueri/SP, Brazil</td>
<td>0800 7017789</td>
</tr>
<tr>
<td><strong>Asia Pacific</strong></td>
<td>Philips Electronics Hong Kong Ltd.&lt;br&gt;6/F, Core Building 1&lt;br&gt;1 Science Park East Avenue&lt;br&gt;Hong Kong Science Park&lt;br&gt;Shatin. New Territories, Hong Kong</td>
<td>(+852) 2821 5888</td>
</tr>
</tbody>
</table>
- Explaining the proper use of application features and answering your questions about how the application works
- Explaining the proper installation and maintenance of Philips HeartStart Configure
- Assisting you in selecting and configuring card readers
- Assisting you in setting up an IrDA connection or in placing a defibrillator in Administration mode

Customer support technicians do not provide help for the following:

- Interpreting ECG or medical data. Please call your medical director
- Repairing hardware. Support technicians can help you determine if you have a hardware problem, but they cannot help you fix problems that are not related to Philips HeartStart Configure software
- Troubleshooting defibrillators. Please call Philips Customer Support and ask for defibrillator support
- Troubleshooting non-Philips products

**Helping us help you**

You can help our technicians give you better support by doing the following:

- Calling from a phone near your computer
- Having the application started and running
- Having the following information available. This information is available by clicking the Help menu, and then clicking About:
  - Product information, including the model number
  - Serial number
  - Software revision or version
- Knowing the version of Windows that you are using
- Knowing the software's installed options (if applicable)
- Having a written copy of the error message text
- Recording details about the activity and task you were doing when the error occurred
[This page intentionally left blank]
Configuration parameter field descriptions

Use the configuration parameter field description tables when you change configuration fields for your HeartStart defibrillator. These tables define the parameter settings, and show both the default and nondefault settings.

It is the responsibility of the medical director to interpret a parameter and select the correct setting based on your institution's requirements.

You should make changes only under the direction of a medical director. Changing settings changes the way the defibrillator operates in an emergency. Since many patient-care protocol parameters interact with each other, it is important to understand how each parameter affects the protocol.

The American Heart Association (AHA), European Resuscitation Council, and International Liaison Committee on Resuscitation (ILCOR) periodically publish guidelines that advise on best practices for resuscitation. When the guidelines are published, Philips updates the programming of its defibrillators accordingly.

Some older device models cannot be changed with HeartStart Configure to meet the new guidelines. These old device models must be returned to the factory for the upgrade. For example, the early models of HS1 cannot be reconfigured by HeartStart Configure to meet the 2005 or 2010 guidelines.
HeartStart FR3 configuration parameters

The HeartStart FR3 is shipped with a factory-default setup optimized for 2010 guidelines. This is designed to meet the needs of most users. You can also configure the HeartStart FR3 extensively.

This topic describes the HeartStart FR3 configuration parameters. For more information on how to implement these parameters for specific uses, see the HeartStart FR3 defibrillator instructions for administrators.

Some settings are valid only on newer versions of the HeartStart FR3. If you attempt to apply newer parameters to an older defibrillator that does not support these parameters, then the parameter will be automatically reset to its default value. Refer to the parameter descriptions that follow for details.

To ensure that your configuration changes have been correctly transmitted to the defibrillator, always retrieve and check the defibrillator configuration before using the defibrillator.

Default field settings in the menus appear in bold black typeface. If there are any nondefault settings in the workspace, they appear in blue typeface.

Overview group

Configuration name
Displays the name of the configuration.
You can change the assigned name.

Configuration description
Displays the description of the configuration.
You can change the description by typing details in the box.

Date modified
Displays the date and time at which the configuration was created or last updated.
HeartStart FR3 configuration parameters

User name

Displays the user name of the user who modified the configuration.
You can type a unique user name.

Device group

The device operation parameter settings determine the basic behavior of HeartStart FR3, irrespective of individual protocols.

Volume

Sets the HeartStart FR3 speaker volume.
The allowable settings are:

- **Loud** (the default setting)
- Medium
- Soft

ECG display

(FR3 ECG model 861389 only)

Enables (ON) or disables (OFF) display of the patient’s ECG on the HeartStart FR3 screen.
The allowable settings are:

- **On** (the default setting)
- Off

Record audio

Enables (ON) or disables (OFF) audio recording on the data card during use.
The allowable settings are:

- On
- **Off** (the default setting)

Carry case auto-on

Enables the unit to turn on automatically by opening the carry case.
The allowable settings are:

- **On** (the default setting)
- Off
HeartStart FR3 configuration parameters

**Wireless PIN**

Sets the *Bluetooth* personal identification number (PIN). Required only for use with the optional *Bluetooth* wireless transceiver module.

- You can change the *Bluetooth* PIN only through HeartStart Configure.

For security reasons, the PIN is not displayed on the HeartStart FR3 screen.

In the View Setup feature in Administration mode, the PIN is shown as “Default” if it has never been changed, or “****” if it has been changed using HeartStart Configure.

The allowable settings are:

- 4-digit number
- **2071** (the default setting)

**Defibrillation**

These parameters govern the number of and time between defibrillation shocks in a shock series.

**Shock series**

(Number of shocks per stack)

Sets the number of shocks in a series that must be delivered before the HeartStart FR3 automatically activates a Basic CPR Interval.

A new shock series begins when a shock is delivered in any of the following circumstances:

- After the HeartStart FR3 is turned on
- After a completion of any CPR protocol
- When the **Shock series** setting is greater than 1, and if the time since the previous shock exceeds the shock series interval setting

The allowable settings are:

- **1** (the default setting)
- 2
- 3
- 4
HeartStart FR3 configuration parameters

**Shock Series Interval**

Sets the time interval used to determine if a delivered shock should be counted as part of the current shock series. This parameter applies only when the Shock series setting is greater than 1. The time interval is in minutes.

If you click Infinite, then the shock protocol will not time out until the configured number of shocks per stack (shock series) has been delivered.

The allowable settings are:

- **1** (the default setting)
- **2**
- **Infinite**

**Advanced mode use**

Enables (ANALYZE and CHARGE) or disables (OFF) advanced mode.

**ANALYZE** – The HeartStart FR3 permits user-initiated rhythm analysis when the FR3 entered the advanced mode.

**CHARGE** – The HeartStart FR3 permits user-initiated rhythm analysis, and charge and disarm when the advanced mode is entered.

For more information, see the Advanced Mode appendix in the *FR3 defibrillator instructions for administrators* guide.

The allowable settings are:

- **Analyze**
- **Charge** (available only for the FR3 ECG model)
- **Off** (the default setting)

**Advanced use prompt repeat rate**

Sets the repeat rate for patient care prompts provided by the HeartStart FR3 when Advanced mode use is configured to ANALYZE or CHARGE. The repeat rate is in minutes.

For more information, see the Advanced Mode appendix in the *FR3 defibrillator instructions for administrators* guide.

The allowable settings are:

- **.5** (the default setting)
- **1.0**
- **2.0**
Self-test group

The periodic self-tests (PST) conducted by HeartStart FR3 can be configured to test for certain preconnected accessories. Although the default setting is OFF, HeartStart FR3 automatically tests any accessory connected to it during periodic self-tests. However, if self-test for an accessory is configured to ON and HeartStart FR3 does not detect the accessory, it provides alert chirps.

Test for pads

Enables (ON) or disables (OFF) testing for the presence of preconnected pads during each self-test.

The allowable settings are:

- On
- Off (the default setting)

Test for data card

Enables (ON) or disables (OFF) testing for the presence of an installed data card during each self-test.

The allowable settings are:

- On
- Off (the default setting)

General CPR group

General CPR parameters apply to all CPR protocols. The HeartStart FR3 provides three kinds of separately configurable CPR protocols. The kind of CPR protocol applied depends on its context in the patient care cycle.

Basic CPR — Upon completion of a shock series (the default shock series is one shock), the HeartStart FR3 provides a CPR protocol.

CPR First — The HeartStart FR3 provides a CPR protocol before defibrillation therapy, based on the selected SMART CPR algorithm or the User setting.

NSA CPR — After a no-shock-advised (NSA) decision, the HeartStart FR3 provides an attend-to-patient period with a CPR option button or, if NSA CPR is configured ON, an NSA CPR protocol.
HeartStart FR3 configuration parameters

Each of these three protocol types can also be configured separately for adult and infant/child applications, for a total of six distinct CPR protocols.

Unless otherwise noted, these parameters pertain to all adult and infant/child CPR protocols (Basic CPR, CPR First, and NSA CPR) initiated by the HeartStart FR3. If you change a general CPR parameter setting, it will be applied to every CPR protocol.

CPR protocols are time-based, using the selected CPR duration setting.

Metronome

Enables (ON) and disables (OFF) audio beats for CPR compressions.

Metronome audio beats, if enabled, will mask ambient sounds during CPR in the recorded audio data.

The allowable settings are:

On
Off (This is the default setting.)

CPR While Armed

Allows the user to perform CPR after a shock decision has been made but before the user presses the shock button.

The allowable settings are:

On
Off (This is the default setting.)

CPR First

Sets whether the HeartStart FR3 provides an interval for CPR prior to defibrillation, in the first rhythm analysis in a device use.

The Analyze option button is always available in any CPR First protocol. Press the designated option button to initiate HeartStart FR3 analysis of heart rhythm.

The allowable settings are:

Off (This is the default setting.) – The HeartStart FR3 never provides an initial CPR interval before rhythm analysis.
**SMART CPR auto1** – The HeartStart FR3 uses a more conservative rhythm analysis system to determine if the presenting shockable heart rhythm is characteristic of long downtime (and therefore the patient should receive CPR first). "Conservative" means that it is less likely to recommend CPR first.

**SMART CPR auto2** – The HeartStart FR3 uses a more aggressive rhythm analysis system to determine if the presenting shockable heart rhythm is characteristic of long downtime (and therefore the patient should receive CPR first). "Aggressive" means that it is more likely to recommend CPR first.

**User** (User-initiated CPR Protocol) – The HeartStart FR3 provides a protocol in which responders can initiate the configured CPR protocol at any time by pressing the CPR option button.

**Always** - The HeartStart FR3 always provides an interval for CPR prior to defibrillation, in the first rhythm analysis in a device use.

The Always value is supported on HeartStart FR3 with software version 2.0 or later. If this value is not available on your HeartStart FR3 model, and you choose it, your HeartStart FR3 will change the parameter to the default value, which is Off.

**No Shock Advised (NSA) action**

Sets HeartStart FR3 behavior during the attend-to-patient period that follows any NSA (no-shock-advised) decision. During this period, the responder can perform CPR or otherwise attend to the patient, as needed.

Important: When configured to NSA CPR, the HeartStart FR3 enables CPR Coaching for use during the attend-to-patient period.

For more information on how to implement HeartStart FR3 **NSA action** parameters, see the NSA Action appendix in the *FR3 defibrillator instructions for administrators* guide.

When configured to NSA CPR, the HeartStart FR3 enables configuration of **NSA CPR Coaching** for use during the attend-to-patient period. NSA CPR Coaching settings are ALWAYS and USER.

The allowable settings are:

**NSA CPR** (the default setting)

NSA Monitor
**NSA CPR coaching**

Sets the type of coaching during the attend-to-patient period when **NSA action** is set to NSA CPR.

When configured to **NSA CPR**, this allows selection of NSA CPR Coaching following an NSA decision, either at user discretion (USER) or ALWAYS.

The allowable settings are:
- **Always** (the default setting)
- **User**

**NSA Monitor prompt repeat rate**

Sets the repeat rate for patient care prompts provided by the HeartStart FR3 during monitoring, only when **NSA action** is set to MONITOR. The repeat rate is in minutes.

For more information, see the Configuration chapter and NSA Action appendix in the *FR3 defibrillator instructions for administrators* guide.

The allowable settings are:
- **1.0** (the default setting)
- 2.0
- 3.0
- Infinite – Select if you do not want to provide repeat prompting during background monitoring.

**CPR option button**

Enables (ON) or disables (OFF) the ability to initiate a Basic CPR protocol by pressing the designated option button, when active during rhythm analysis or a shock related sequence, on the front panel of the HeartStart FR3.

The allowable settings are:
- **On**
- **Off** (the default setting)

**Analyze option button**

Enables (ON) or disables (OFF) ability to interrupt a CPR protocol, NSA monitoring, or attend-to-patient period and resume rhythm analysis, by pressing the designated option button on the front panel of the HeartStart FR3.

The allowable settings are:
HeartStart FR3 configuration parameters

On
Off (the default setting)

Protocol-specific CPR group

Specific CPR parameters apply to each CPR protocol individually. In other words, each of these CPR Duration parameters can be configured separately for adult and infant/child CPR protocols.

**Adult CPR First duration**

Sets the length of the CPR protocol for **Adult CPR First**. The length of the protocol is in minutes.

The allowable settings are:

1.0
1.5
2.0 (the default setting)
2.5
3.0

**Adult Basic CPR duration**

Sets the length of the CPR protocol for **Adult Basic CPR**. The length of the protocol is in minutes.

The allowable settings are:

1.0
1.5
2.0 (the default setting)
2.5
3.0

**Adult NSA CPR duration**

Sets the attend-to-patient period for the **Adult NSA CPR**. The length of the protocol is in minutes.

The allowable settings are:

1.0
1.5
2.0 (the default setting)
2.5
3.0
Infant/child CPR First duration

Sets the length of the CPR protocol for Infant/child CPR First. The length of the protocol is in minutes.

The allowable settings are:

- 1.0
- 1.5
- **2.0** (the default setting)
- 2.5
- 3.0

Infant/child Basic CPR duration

Sets the length of the CPR protocol for Infant/child Basic CPR. The length of the protocol is in minutes.

The allowable settings are:

- 1.0
- 1.5
- **2.0** (the default setting)
- 2.5
- 3.0

Infant/child NSA CPR duration

Sets the length of the CPR protocol for Infant/child NSA CPR. The length of the protocol is in minutes.

The allowable settings are:

- 1.0
- 1.5
- **2.0** (the default setting)
- 2.5
- 3.0
HeartStart FRx 2005 and 2010 guidelines configuration parameters

These configuration parameters are for a HeartStart FRx programmed to observe 2005 and 2010 guidelines. For more information on how to implement FRx parameters for specific uses, see the HeartStart FRx owner’s manual.

When HeartStart Configure retrieves a configuration, the serial number for the defibrillator appears in the title bar for the workspace.

To ensure that your configuration changes have been correctly transmitted to the defibrillator, always retrieve and check the defibrillator configuration before using the defibrillator.

Default field settings in the menus appear in bold black typeface. If there are any nondefault settings in the workspace, they appear in blue typeface.

Overview group

In the Overview, you can type a configuration identifier into text boxes for the configuration. This view also indicates the last date and time that the configuration was modified.

Configuration name

Displays the name of the configuration.

You can type a name to change the configuration name.

Configuration description

Displays the description of the configuration.

You can change the description by entering details into the text box.

Date modified

Displays the date and time that the configuration was created or last updated.

User Name

Displays the user name of the user who modified the configuration.

You can type a unique user name.
Device group

The device operation parameter settings determine the basic behavior of the HeartStart FRx, irrespective of individual protocols.

Volume

Sets the volume of the defibrillator speaker. 1 is lowest; 8 is highest. The defibrillator uses the speaker for voice instructions and the charge-done tone. The allowable settings are:

1
2
3
4
5
6
7
8 (the default setting)

Send ECG

Enables (ON) or disables (OFF) the ability to send ECG information (in real time) from the defibrillator's infrared (IrDA) window.

Also known as "ECG out."

The allowable settings are:

On (the default setting)
Off

AutoSend periodic self-test (PST)

Enables (ON) or disables (OFF) the ability of the defibrillator to automatically send periodic self-tests from the device's infrared (IrDA) window.

The allowable settings are:

On (the default setting)
Off

Defibrillation group

These parameters govern the number of and time between defibrillation shocks in a shock series.
Shock Series

(Number of shocks per stack)
Sets the number of shocks in a series that must be delivered to start the automatic protocol pause for patient assessment and CPR.
During the protocol pause, the defibrillator does not perform rhythm analysis.
The protocol pause timer setting determines the length of the protocol pause after the defibrillator completes a shock series.
The allowable settings are:
1 (the default setting)
2
3
4

Shock Series Interval

Sets the time interval used to determine if a delivered shock should be counted as part of the current shock series. This parameter applies only when the Shock series setting is greater than 1. The time interval is in minutes.
The allowable settings are:
1 (the default setting)
2
Infinite

CPR group

The following parameters determine how the HeartStart FRx orchestrates CPR protocol.

No Shock Advised pause type

Sets the pause type following a No Shock Advised decision.
The allowable settings are:
Standard – The defibrillator does not perform rhythm analysis during the pause. The pause time is determined by the selected protocol pause timer and No Shock Advised pause timer settings.
SMART (the default setting) - The defibrillator conducts background monitoring during the pause.
HeartStart FRx 2005 and 2010 guidelines configuration parameters

If the defibrillator detects a potentially shockable rhythm, the defibrillator ends the SMART pause and resumes rhythm analysis (unless CPR or CPR coaching is being performed).
If CPR or CPR coaching is being performed, the SMART NSA pause is converted to a standard NSA.

**No Shock Advised pause timer**

Sets the length of the No Shock Advised (NSA) pause interval. The NSA pause interval starts after an NSA decision. The pause interval is in minutes.
If the defibrillator delivers a shock within the shock series interval, the defibrillator overrides this setting and defines the length of the pause by the protocol pause timer setting.
The allowable settings are:
- 0.5
- 1.0
- 1.5
- **2.0** (the default setting)
- 2.5
- 3.0

**Protocol pause timer**

Sets the length of the CPR pause interval. The two-minute CPR pause interval automatically starts after the defibrillator completes voice instruction and a shock series.

After the protocol pause, the defibrillator returns to automatic rhythm analysis.
The allowable settings are:
- 0.5
- 1.0
- 1.5
- **2.0** (the default setting)
- 2.5
- 3.0

**CPR compression ratio**

Sets the rate for CPR compression signals provided by the defibrillator. The compression ratio is the number of compressions and breaths administered during a minute.
Pauses begin and end with compressions.
The allowable settings are:

- **Adult = 30:2, Pediatric = 30:2** (the default setting)
- Adult = 30:2, Pediatric = 15:2
- Adult = 15:2, Pediatric = 15:2

**CPR adult ventilation**

Specifies that the responders use ventilation prompts at the ventilation ratio for adults while the defibrillator is in use.

- Choose **With ventilation** if responders provide ventilation when performing CPR with adult pads.
- Choose **No ventilation** if coaching will be compressions-only when an adult pads connector is installed.

The allowable settings are:

- **With ventilation** (the default setting)
- No ventilation

**CPR infant/child ventilation**

Specifies that the responders use ventilation prompts at the ventilation ratio for children and infants while the defibrillator is in use.

- Choose **With ventilation** if responders provide ventilation when performing CPR with an Infant/Child Key inserted.
- Choose **No ventilation** if coaching will be compressions-only when an Infant/Child Key is inserted.

The allowable settings are:

- **With ventilation** (the default setting)
- No ventilation

**Voice Prompts group**

Determines the timing and content of key protocol voice instructions.

**Call EMS voice instruction**

Sets the point during the response (at the start of the first patient care pause) when the defibrillator plays the voice instruction to call emergency medical services.

The allowable settings are:

- At power on
- At power on and at the start of the first pause interval
HeartStart FRx 2005 and 2010 guidelines configuration parameters

At the start of the first pause interval (the default setting)
No reminder

CPR prompt
Sets the CPR reminder voice prompts.
The allowable settings are:
  CPR 1: Begin CPR.
  CPR 2: It is safe to touch the patient. Begin CPR.
  CPR 3: Begin CPR. For help with CPR, press the flashing blue button.
  **CPR 4** (the default setting): It is safe to touch the patient. Begin CPR. For help with CPR, press the flashing blue button.
HeartStart FRx 2000 guideline configuration parameters

These configuration parameters are for a HeartStart FRx defibrillator programmed to observe the 2000 guidelines. For more information on how to set your HeartStart FRx parameters for specific uses, see the HeartStart FRx defibrillator owner’s manual, Edition 5.

When HeartStart Configure retrieves a configuration, the serial number for the defibrillator appears in the title bar for the workspace.

To ensure that your configuration changes have been correctly transmitted to the defibrillator, always retrieve and check the defibrillator configuration before using the defibrillator.

Default field settings in the menus appear in bold black typeface. If there are any nondefault settings in the workspace, they appear in blue typeface.

Overview group

In the Overview, you can type your own configuration identifier information into boxes for the configuration. This display also indicates the last date and time that the configuration was modified.

Configuration name

The name of the configuration.
You can change the assigned name.

Configuration description

The description of the configuration.
You can change the description by typing details into the box.

Date modified

The date and time that the configuration was created or last updated.

User Name

The user name of the user who modified the configuration.
You can type a unique user name.
Device group

The device operation parameter settings determine the basic behavior of the HeartStart FRx, irrespective of individual protocols.

Volume

Sets the volume of the defibrillator speaker. 1 is lowest; 8 is highest.

The defibrillator uses the speaker for voice instructions and the charge-done tone.

The allowable settings are:

1
2
3
4
5
6
7
8 (the default setting)

Send ECG

Enables (ON) or disables (OFF) the ability to send ECG information (in real time) from the defibrillator infrared (IrDA) window.

Also known as "ECG out."

The allowable settings are:

On (the default setting)
Off

AutoSend periodic self-test (PST)

Enables (ON) or disables (OFF) the ability of the defibrillator to automatically send periodic self-tests from the defibrillator infrared (IrDA) window.

The allowable settings are:

On (the default setting)
Off
HeartStart FRx 2000 guideline configuration parameters

Defibrillation group

These parameters govern the number of and time between defibrillation shocks in a shock series.

Shock Series

(Number of shocks per stack)
Sets the number of shocks in a series that must be delivered to start the automatic protocol pause for patient assessment and CPR.
During the protocol pause, the defibrillator does not perform rhythm analysis.
The protocol pause timer setting determines the length of the protocol pause after the defibrillator completes a shock series.
The allowable settings are:

1
2
3 (the default setting)
4

Shock Series Interval

Sets the time interval used to determine if a delivered shock should be counted as part of the current shock series. This parameter applies only when the shock series setting is greater than 1. The time interval is in minutes.
The allowable settings are:

1 (the default setting)
2
Infinite

CPR group

The following parameters determine how the HeartStart FRx orchestrates the CPR protocol.

No Shock Advised pause type

Sets the type of pause following a No Shock Advised decision.
The allowable settings are:
HeartStart FRx 2000 guideline configuration parameters

Standard – The defibrillator does not perform rhythm analysis during the pause. The pause time is determined by the selected protocol pause timer and **No Shock Advised pause timer** settings.

**SMART** (the default setting): The defibrillator conducts background monitoring during the pause. If the defibrillator detects a potentially shockable rhythm, the defibrillator ends the SMART pause and resumes rhythm analysis (unless CPR or CPR coaching is being performed).

If CPR or CPR coaching is being performed, the SMART NSA pause is converted to a standard NSA pause.

**No Shock Advised pause timer**
Sets the length of the No Shock Advised (NSA) pause interval. The NSA pause interval starts after an NSA decision. The pause interval is in minutes.

If the defibrillator delivers a shock within the shock series interval, the defibrillator overrides this setting and defines the length of the pause by the protocol pause timer setting.

The allowable settings are:
- 0.5
- **1.0** (the default setting)
- 1.5
- 2.0
- 2.5
- 3.0

**Protocol pause timer**
Sets the length of the CPR pause interval. The CPR pause interval starts after the defibrillator completes voice instruction and a shock series. After the protocol pause, the defibrillator returns to automatic rhythm analysis. The pause interval is in minutes.

The allowable settings are:
- 0.5
- **1.0** (the default setting)
- 1.5
- 2.0
- 2.5
- 3.0
CPR prompt rate

Sets the rate for CPR compression signals provided by the defibrillator. The compression rate is the number of compressions administered during a minute.

The allowable settings are:

- 80
- **100** (the default setting)

CPR adult ventilation

Specifies that the responders use ventilation prompts at the ventilation ratio for adults while the defibrillator is in use.

- Choose **With ventilation** if responders provide ventilation when performing CPR with adult pads.
- Choose **No ventilation** if coaching will be compressions-only when an adult pads connector is installed.

The allowable settings are:

**With ventilation** (the default setting)

No ventilation

CPR infant/child ventilation

Specifies that the responders use ventilation prompts at the ventilation ratio for children and infants while the defibrillator is in use.

- Choose **With ventilation** if responders provide ventilation when performing CPR with an Infant/Child Key inserted.
- Choose **No ventilation** if coaching will be compressions-only when an Infant/Child Key is inserted.

The allowable settings are:

**With ventilation** (the default setting)

No ventilation

Voice Prompts group

Determines the timing and content of key protocol voice instructions.

Call EMS voice instruction

Sets the point when the defibrillator plays the voice instruction to call emergency medical services.

The allowable settings are:

- At power on
- At power on and at the start of the first pause interval
HeartStart FRx 2000 guideline configuration parameters

At the start of the first pause interval (the default setting)
No reminder

CPR prompt

Sets the CPR reminder voice prompts.

The allowable settings are:

CPR 1: If needed, begin CPR.
CPR 2: Check airway, breathing, circulation. If needed, begin CPR.
CPR 3: If needed, begin CPR. Press the blue button for CPR coaching.
CPR 4 (the default setting): Check airway, breathing, circulation. If needed, begin CPR. Press the blue button for CPR coaching.
HeartStart HS1 2005 and 2010 guidelines configuration parameters

These configuration parameters are for the HeartStart HS1 that is programmed to observe 2005 and 2010 guidelines. For detailed discussions on how to implement HS1 parameters for specific uses, see the *HeartStart HS1 defibrillator owner’s manual*.

When HeartStart Configure retrieves a configuration, the defibrillator serial number appears in the title bar for the workspace.

To ensure that your configuration changes have been correctly transmitted to the defibrillator, always retrieve and check the defibrillator configuration before using the defibrillator.

Default field settings in the menus appear in **bold** black typeface. If there are any nondefault settings in the workspace, they appear in **blue** typeface.

### Overview group

In the Overview, you can type a configuration identifier into boxes for the configuration. This area also indicates the last date and time that the configuration was modified.

**Configuration name**

Displays the name of the configuration.

You can change the assigned name.

**Configuration description**

Displays the description of the configuration.

You can change the description by typing details in the box.

**Date modified**

Displays the date and time when the configuration was created or last updated.

**User Name**

Displays the user name of the user who modified the configuration.

You can type a unique user name.
**Device group**

The device operation parameter settings determine the basic behavior of the HeartStart HS1, irrespective of individual protocols.

**Volume**

Sets the volume of the defibrillator speaker. 1 is lowest; 8 is highest.

The defibrillator uses the speaker for voice instructions and the charge-done tone.

The allowable settings are:

1 2 3 4 5 6 7 8 (the default setting)

**Send ECG**

Enables (ON) or disables (OFF) the ability to send ECG information (in real time) from the defibrillator infrared (IrDA) window.

Also known as "ECG out."

The allowable settings are:

On (the default setting)
Off

**AutoSend periodic self-test (PST)**

Enables (ON) or disables (OFF) the ability of the defibrillator to automatically send periodic self-tests from the device's infrared (IrDA) window.

The allowable settings are:

On (the default setting)
Off
Defibrillation group

These parameters govern the number of and time between defibrillation shocks in a shock series.

**Shock Series**

(Number of shocks per stack)

Sets the number of shocks in a series that must be delivered to start the automatic protocol pause for patient assessment and CPR.

During the protocol pause, the defibrillator does not perform rhythm analysis.

The protocol pause timer setting determines the length of the protocol pause after the defibrillator completes a shock series.

The allowable settings are:

- **1** (the default setting)
- 2
- 3
- 4

**Shock Series Interval**

Sets the time interval used to determine if a delivered shock should be counted as part of the current shock series.

This parameter applies only when the **Shock series** setting is greater than 1. The interval is in minutes.

The allowable settings are:

- **1** (the default setting)
- 2
- Infinite

CPR group

These parameters determine how HeartStart HS1 orchestrates the CPR protocol.

**No Shock Advised pause type**

Sets the type of pause following a No Shock Advised decision.

The allowable settings are:
HeartStart HS1 2005 and 2010 guidelines configuration parameters

Standard: The defibrillator does not perform rhythm analysis during the pause. The pause time is determined by the selected protocol pause timer and **No Shock Advised pause timer** settings.

**SMART** (the default setting): The defibrillator conducts background monitoring during the pause. If the defibrillator detects a potentially shockable rhythm, the defibrillator ends the SMART pause and resumes rhythm analysis (unless CPR or CPR coaching is being performed).

If CPR or CPR coaching is being performed, the SMART NSA pause converts to a standard NSA pause.

**No Shock Advised pause timer**

Sets the length of the No Shock Advised (NSA) pause interval. The NSA pause interval starts after an NSA decision. The pause interval is in minutes.

If the defibrillator delivers a shock within the shock series interval, the defibrillator overrides this setting and defines the length of the pause by the protocol pause timer setting.

The allowable settings are:
- 0.5
- 1.0
- 1.5
- **2.0** (the default setting)
- 2.5
- 3.0

**Protocol pause timer**

Sets the length of the CPR pause interval. The CPR pause interval starts after the defibrillator completes voice instruction and a shock series. After the protocol pause, the defibrillator returns to automatic rhythm analysis. The pause interval is in minutes.

The allowable settings are:
- 0.5
- 1.0
- 1.5
- **2.0** (the default setting)
- 2.5
- 3.0
HeartStart HS1 2005 and 2010 guidelines configuration parameters

**CPR compression ratio**

Sets the rate for CPR compression signals provided by the defibrillator. The compression ratio is the number of compressions and breaths administered during a minute.

Pauses begin and end with compressions.

The allowable settings are:

- **Adult = 30:2, Pediatric = 30:2** (the default setting)
- Adult = 30:2, Pediatric = 15:2
- Adult = 15:2, Pediatric = 15:2

**CPR adult ventilation**

Specifies that the responders use ventilation prompts at the ventilation ratio for adults while the defibrillator is in use.

- Choose **With ventilation** if responders provide ventilation when performing CPR with adult pads.
- Choose **No ventilation** if coaching will be compressions-only when an adult pads connector is installed.

The allowable settings are:

- **With ventilation** (the default setting)
- No ventilation

**CPR infant/child ventilation**

Specifies that the responders use ventilation prompts at the ventilation ratio for children and infants while the defibrillator is in use.

- Choose **With ventilation** if responders provide ventilation when performing CPR with infant/child pads connected.
- Choose **No ventilation** if coaching will be compressions-only when an infant/child pads connector is installed.

The allowable settings are:

- **With ventilation** (the default setting)
- No ventilation

**Voice Prompts group**

Determines the timing and content of key protocol voice instructions.

**Call EMS voice instruction**
HeartStart HS1 2005 and 2010 guidelines configuration parameters

Sets the point at which the defibrillator plays the voice instruction to call emergency medical services.

The allowable settings are:

- At power on
- At power on and at the start of the first pause interval
- **At the start of the first pause interval** (the default setting)
- No reminder

**CPR prompt**

Sets the CPR reminder voice prompts.

The allowable settings are:

- **CPR 1**: Begin CPR.
- **CPR 2**: It is safe to touch the patient. Begin CPR.
- **CPR 3**: Begin CPR. For help with CPR, press flashing blue button.
- **CPR 4** (the default setting): It is safe to touch the patient. Begin CPR. For help with CPR, press the flashing blue button.
HeartStart HS1 2000 guidelines configuration parameters

These configuration parameters are for the HeartStart HS1 defibrillator programmed to observe the 2000 guidelines. For more information on how to set HeartStart HS1 parameters for specific uses, see the HeartStart HS1 defibrillator owners' manual.

To ensure that your configuration changes have been correctly transmitted to the defibrillator, always retrieve and check the defibrillator configuration before using the defibrillator.

When HeartStart Configure retrieves a configuration, the defibrillator serial number appears in the title bar for the workspace.

Default field settings in the menus appear in bold black typeface. If there are any nondefault settings in the workspace, they appear in blue typeface.

Overview group

In the Overview, you can type your own configuration identifier information into text boxes. This area also indicates the last date and time that the configuration was modified.

Configuration name

Displays the name of the configuration.
You can change the assigned name.

Configuration description

Displays the description of the configuration.
You can change the description by typing details in the box.

Date modified

Displays the date and time that the configuration was created or last updated.

User Name

Displays the user name of the user who modified the configuration.
You can type a unique user name.

**Device group**

The device operation parameter settings determine the basic behavior of HeartStart HS1, irrespective of individual protocols.

**Volume**

Sets the volume of the defibrillator speaker. 1 is lowest; 8 is highest. The defibrillator uses the speaker for voice instructions and the charge-done tone.

The allowable settings are:

1
2
3
4
5
6
7
8 (the default setting)

**Send ECG**

Enables (ON) or disables (OFF) the ability to send ECG information (in real time) from the defibrillator IrDA window.

Also known as "ECG out."

The allowable settings are:

**On** (the default setting)

**Off**

**AutoSend periodic self-test (PST)**

Enables (ON) or disables (OFF) the ability of the defibrillator to automatically send periodic self-tests from the defibrillator's infrared (IrDA) window.

The allowable settings are:

**On** (the default setting)

**Off**
HeartStart HS1 2000 guidelines configuration parameters

Defibrillation group

These parameters govern the number of, and time between, defibrillation shocks in a shock series.

Shock series

(Number of shocks per stack)
Sets the number of shocks in a series that must be delivered to start the automatic protocol pause for patient assessment and CPR.
During the protocol pause, the defibrillator does not perform rhythm analysis.
The protocol pause timer setting determines the length of the protocol pause after the defibrillator completes a shock series.
The allowable settings are:

1
2
3 (the default setting)
4

Shock Series Interval

Sets the time interval used to determine if a delivered shock should be counted as part of the current shock series. This parameter applies only when the Shock series setting is greater than 1. The interval is in minutes.
The allowable settings are:

1 (the default setting)
2
Infinite

CPR group

These parameters determine how the HeartStart HS1 orchestrates the CPR protocol.

No Shock Advised pause type

Sets the type of pause following a No Shock Advised decision.
The allowable settings are:
Standard: The defibrillator does not perform rhythm analysis during the pause. The pause time is determined by the selected protocol pause timer and **No Shock Advised pause timer** settings.

**SMART** (the default setting): The defibrillator conducts background monitoring during the pause. If the defibrillator detects a potentially shockable rhythm, the defibrillator ends the SMART pause and resumes rhythm analysis (unless CPR or CPR coaching is being performed).

If CPR or CPR coaching is being performed, the SMART NSA pause converts to a standard NSA pause.

**No Shock Advised pause timer**

Sets the length of the No Shock Advised (NSA) pause interval. The NSA pause interval starts after an NSA decision. The pause interval is in minutes.

If the defibrillator delivers a shock within the shock series interval, the defibrillator overrides this setting and defines the length of the pause by the protocol pause timer setting.

The allowable settings are:

0.5

1.0 (the default setting)

1.5

2.0

2.5

3.0

**Protocol pause timer**

Sets the length of the CPR pause interval. The CPR pause interval starts after the defibrillator completes voice instruction and a shock series.

After the protocol pause, the defibrillator returns to automatic rhythm analysis. The pause interval is in minutes.

The allowable settings are:

0.5

1.0 (the default setting)

1.5

2.0

2.5

3.0
HeartStart HS1 2000 guidelines configuration parameters

**CPR prompt rate** (compressions per minute)

Sets the rate for CPR compression signals provided by the defibrillator. The compression ratio is the number of compressions administered during a minute.

The allowable settings are:

- 80
- **100** (the default setting)

**Voice Prompts group**

Determines the timing and content of key protocol voice instructions.

**Call EMS voice instruction**

Sets the point when the defibrillator plays the voice instruction to call emergency medical services.

The allowable settings are:

- At power on
- At power on and at the start of the first pause interval
  - **At the start of the first pause interval** (the default setting)
- No reminder

**CPR prompt**

Sets the CPR reminder voice prompts.

The allowable settings are:

- CPR 1: Check circulation. If needed, begin CPR.
- CPR 2: Check airway. Check breathing. Check circulation. If needed, begin CPR.
- CPR 3: Check circulation. If needed, begin CPR. For help with CPR, press the flashing blue button.
- **CPR 4** (the default setting): Check airway. Check breathing. Check circulation. If needed, begin CPR. For help with CPR, press the flashing blue button.
System Log messages

Use the System Log to monitor HeartStart Configure system activity and to troubleshoot problems. For more information, see Working with the System Log on page 69.

There are three types of System Log messages:

- **Error** messages describe incomplete actions.
- **Information** messages describe the actions that HeartStart Configure completes successfully.
- **Warning** messages describe important information, such as when the user has suppressed the general warning message that appears when HeartStart Configure starts.

The following table identifies the type of message, the message as it appears in the action column, and a description or example of messages.

Examples are in parentheses.

<table>
<thead>
<tr>
<th>Type of message</th>
<th>Action</th>
<th>Description and example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td>Export configuration</td>
<td>Failed to export configuration (Name = HS1, Pathname = C:\Documents and Settings\MyComputer\Desktop\Configurations\HS12000.xml.)</td>
</tr>
<tr>
<td>Error</td>
<td>Hands-only wizard retrieve</td>
<td>Retrieve failed (Error = error description)</td>
</tr>
<tr>
<td>Error</td>
<td>Hands-only wizard send</td>
<td>Send failed (Error = error description)</td>
</tr>
<tr>
<td>Type of message</td>
<td>Action</td>
<td>Description and example</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Error</td>
<td>Import configuration</td>
<td>Failed to import file (Pathname = C:\Documents and Settings\MyComputer\Desktop\Configurations\FRx2005.xml.)</td>
</tr>
<tr>
<td>Error</td>
<td>Retrieve configuration</td>
<td>Configuration retrieve failed: (Error = Failed to Retrieve)</td>
</tr>
<tr>
<td>Error</td>
<td>Update application</td>
<td>Failed in check for application updates</td>
</tr>
<tr>
<td>Error</td>
<td>Update application</td>
<td>Failed to update the application</td>
</tr>
<tr>
<td>Error</td>
<td>Save configuration</td>
<td>Updated the application</td>
</tr>
<tr>
<td>Error</td>
<td>Send configuration</td>
<td>Send failed: (Model = FR3, Error = Configuration send failed)</td>
</tr>
<tr>
<td>Error</td>
<td>Set the defibrillator clock</td>
<td>Failed to set the defibrillator clock (Model = FR3, Serial Number = C09B-00000)</td>
</tr>
<tr>
<td>Error</td>
<td>Unexpected error</td>
<td>The following exception occurred: There is an unexpected exception.</td>
</tr>
<tr>
<td>Information</td>
<td>Close application</td>
<td>Closed the application</td>
</tr>
<tr>
<td>Information</td>
<td>Delete configuration</td>
<td>Deleted configuration (Model = FR3, Name = New FR3 2005 configuration)</td>
</tr>
<tr>
<td>Information</td>
<td>Export configuration</td>
<td>Exported configuration (Name = FR3, Pathname = C:\Documents and Settings\MyComputer\Desktop\Configurations\FR32005.xml.)</td>
</tr>
<tr>
<td>Information</td>
<td>Hands-only wizard change protocol</td>
<td>Hands-only changed for adult CPR protocol (Model = device model, Serial Number = device serial number).</td>
</tr>
<tr>
<td>Information</td>
<td>Hands-only wizard change protocol</td>
<td>Hands-only changed for pediatric CPR protocol (Model = device model, Serial Number = device serial number).</td>
</tr>
<tr>
<td>Type of message</td>
<td>Action</td>
<td>Description and example</td>
</tr>
<tr>
<td>----------------</td>
<td>--------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Information</td>
<td>Import configuration</td>
<td>Imported configuration (Pathname = C:\Documents and Settings\MyComputer\Desktop\Configurations\FR32005.xml.)</td>
</tr>
<tr>
<td>Information</td>
<td>Open application</td>
<td>Opened the application</td>
</tr>
<tr>
<td>Information</td>
<td>Update application</td>
<td>Updated the application</td>
</tr>
<tr>
<td>Information</td>
<td>Restore Warning Message</td>
<td>The display of warnings and confirmation messages has been restored.</td>
</tr>
<tr>
<td>Information</td>
<td>Retrieve configuration</td>
<td>Retrieved configuration from the defibrillator (Model = FR3, Serial Number = C09B-00000)</td>
</tr>
<tr>
<td>Information</td>
<td>Save configuration</td>
<td>Created configuration (Model = FR3, Name = New FR3 2005 Configuration)</td>
</tr>
<tr>
<td>Information</td>
<td>Send configuration</td>
<td>Sent configuration to the defibrillator (Model = FRx, Serial Number = 01234)</td>
</tr>
<tr>
<td>Information</td>
<td>Set the defibrillator clock</td>
<td>Set the defibrillator clock succeeded (Model = FR3, Serial Number = C09B-00000)</td>
</tr>
<tr>
<td>Information</td>
<td>Truncate log</td>
<td>The system log was truncated.</td>
</tr>
<tr>
<td>Warning</td>
<td>Suppress Warning Message</td>
<td>The startup warning message has been suppressed by the user. Warnings and confirmations can be restored using the Restore Confirmations command.</td>
</tr>
</tbody>
</table>
**Administration**

Administration mode allows you to apply or change configuration settings in a HeartStart supported defibrillator, and also allows an administrator to view HeartStart Configure activities.

**Administration mode**

A setting on HeartStart defibrillators that allows the defibrillator to send and receive information.

**Administration pane**

The Administration pane allows you to view system log entries for the computer running HeartStart Configure.

**AED**

Stands for Automated External Defibrillator. A defibrillator that automatically performs rhythm analysis of the patient’s surface electrocardiogram.

**All Configurations**

A feature in the Saved Configurations pane that allows you to view all configurations that are available for viewing and editing in HeartStart Configure.

**Archive**

To store or save information.

**Attend to Patient Period**

A period following a no shock Advised (NSA) decision during which the responder may perform CPR, if needed, or otherwise attend to the patient.

**Bluetooth wireless transmission**

Use of an optional FR3 Bluetooth wireless technology transceiver module to transfer a configuration from a HeartStart FR3 defibrillator to a Bluetooth-enabled computer.
Bluetooth®

A short-range wireless technology that uses radio links between a
device such as defibrillators and computers, mobile computers, mobile
phones, and other portable devices.

Bystander CPR

The attempt to perform basic CPR by someone who is not part of an
organized emergency response system. Typically, this person witnessed
the arrest. In certain situations, physicians, nurses, and paramedics
may perform bystander CPR.

Card reader

Hardware that reads information from a data card.

CFG

Stands for configuration file. This binary file extension type is used for a
HeartStart FR3 configuration file.

Configuration

A file that sets the behavior of a defibrillator.

Configurations (feature)

A feature set that allows you to configure, manage, and review
information about a defibrillator configuration. HeartStart Configure
identifies each configuration based on the type, name and the date and
time of the configuration. This allows you to list configurations based on
a variety of values.

Configurations pane

The Configurations pane allows you to view and manage supported
defibrillator configurations.

CPR

Stands for Cardiopulmonary Resuscitation. A technique for providing
artificial respiration and heart compressions to maintain life in a victim
of Sudden Cardiac Arrest (SCA).

DAT

Stands for data file. This binary file format is used by Event Review 3.5
and Event Review Pro 3.5 for HeartStart FRx and HS1 defibrillator
configurations.
Data Card
A computer storage device used for recording and storing information. Some HeartStart defibrillators use data cards to record configuration, ECG, and audio information.

Defibrillator event
Information received from a defibrillator. Examples are alarms, shocks, measurements, and error conditions.

Device
A generic term used for defibrillators and data cards.

ECG
Stands for electrocardiogram. The electrical rhythm of the heart as detected through defibrillator pads.

EMS
Stands for Emergency Medical Services.

Error
Describes a system error or an erroneous input by the user.

Export
Saving a configuration as a file for use on another computer running HeartStart Configure. This is typically done to share a configuration with other users or to back up a configuration.

Feature
A link or button within the HeartStart Configure task pane that allows you to complete a task.

Fibrillation
A disturbance of the normal heart rhythm that results in chaotic, disorganized activity that cannot effectively pump blood. Ventricular fibrillation (fibrillation in the lower chambers of the heart) is the most common cause of sudden cardiac arrest.

FR3
A HeartStart compact, battery-powered automated external defibrillator (AED) designed for use by trained responders to treat ventricular fibrillation (VF), the most common cause of sudden cardiac arrest (SCA).
**FRx**
A HeartStart compact, battery-powered automated external defibrillator (AED) designed for use by trained responders to treat ventricular fibrillation (VF), the most common cause of sudden cardiac arrest (SCA).

**Getting Started**
A task pane in HeartStart Configure that allows you to navigate to online help, selecting accessories, and check for software updates.

**HS1**
A HeartStart compact, battery-powered automated external defibrillator (AED) that is designed for simple and reliable operation by minimally trained users to treat ventricular fibrillation (VF), the most common cause of sudden cardiac arrest (SCA).

**HTTP**

**Import**
Opening a defibrillator configuration file that is not stored in HeartStart Configure, and was created by another user on another installation of HeartStart Configure.

**Incident**
The series of events involved in treating a patient with a defibrillator.

**Information**
Details action and events of an end-user using HeartStart Configure.

**Language Card**
A secure digital (SD) card that can be purchased separately for the HeartStart FR3 defibrillator model. It contains languages used by the local culture. You can either change the primary language, or set a second language for bilingual operation.

**License Manager**
The License Manager allows you to type in your registration key to activate HeartStart Configure software.
**Navigation pane**

Use the navigation pane to navigate to workspaces and to select a defibrillator and perform defibrillator configuration tasks.

**NSA**

Stands for no shock advised. A decision that is made by the defibrillator based on analysis of the patient’s heart rhythm. The defibrillator will not deliver a shock in this mode.

**PST**

For Periodic Self Test. A self-administered test mode that a HeartStart defibrillator runs to ensure that all defibrillator components are functional and work properly. Test results are Pass, Warning, or Call customer support.

**Save**

Adding a new configuration the information and its associated details to the HeartStart Configure data set for reuse later on other defibrillators in order to standardize defibrillator behavior.

**Saved configurations**

The area of the Navigation pane where configurations can be viewed and filtered based on supported defibrillator type.

**Shock series**

Also called shock stack. A sequence of one or more shocks, each separated by no more than a preset interval. After completion of a shock series, the defibrillator automatically provides a CPR protocol.

**SMART analysis**

The proprietary algorithm used by the FR3 to analyze the patient’s heart rhythm and determine whether a shock is advised.

**Smart CPR**

A configurable feature that, either automatically or by manual selection, enables a CPR interval before rhythm analysis and shock decision for patients with a shockable rhythm.

**System log**

The system log lists all monitored application activity. Use the system log to review application usage.

**Task wizard**

A software feature that guides the user through a task.
Glossary

**URL**
Stands for Uniform Resource Locator. An address for a resource on the Internet. URLs are used by Web browsers to locate Internet resources.

**Workspace**
The pane to the right of the HeartStart Configure navigation pane. It displays the active window for entering and viewing information.

**XML**
Stands for eXtensible Markup Language. This file format has a set of rules for encoding documents in machine-readable form. It is used for HeartStart Configure configuration files. A HeartStart Configure file is exported in the XML file format.
## Index

### A

- **accessories, selecting**: 10, 22, 28
- **activation code**: 16
- **software**: 15
- **adapters**: 37
- **administration**
  - **administration mode**: 35
  - **system log**: 26, 30
- **adult CPR**
  - **NSA duration**: 90
- **auto-send periodic self-test**: 93, 99, 105, 111

### B

- **basic CPR**: 86
- **bilingual option**: 44-45
- **Bluetooth adapter**: 10, 36-37, 41

### C

- **call EMS voice instruction**: 96, 102, 108, 114
- **card reader**: 11
- **caution**: 8
- **CD-ROM, use for installation**: 9
- **Click Mode**: 30
- **client**: 10
- **columns**: 71
- **components**: 10
- **configuration field descriptions**: 81
- **configuration name, field**: 82, 92, 98, 104, 110
- **configurations**: 25, 37, 55, 63
  - **creating new**: 65
  - **deleting**: 68
  - **displaying details**: 71
  - **exporting configuration file**: 67
  - **FR3 defibrillators**: 33
  - **FRx defibrillators**: 49
  - **HS1 defibrillators**: 57
  - **introducing Configure**: 19
  - **modifying**: 39, 53, 62
  - **opening**: 66
  - **parameters**: 93
  - **starting Configure**: 12
  - **types of users**: 20
  - **uninstalling Configure**: 13
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>viewing saved                                                        66</td>
</tr>
<tr>
<td>working in Configure                                                25</td>
</tr>
<tr>
<td>working with configurations                                        65</td>
</tr>
<tr>
<td>workspace                                                           28</td>
</tr>
<tr>
<td>Confirmation messages</td>
</tr>
<tr>
<td>disabling                                                           75</td>
</tr>
<tr>
<td>restoring                                                           75</td>
</tr>
<tr>
<td>connection state                                                    43</td>
</tr>
<tr>
<td>connections, setting up</td>
</tr>
<tr>
<td>infrared                                                            58</td>
</tr>
<tr>
<td>copyright                                                           2</td>
</tr>
<tr>
<td>CPR</td>
</tr>
<tr>
<td>adult NSA, duration                                                 90</td>
</tr>
<tr>
<td>adult ventilation, field</td>
</tr>
<tr>
<td>96, 102, 108</td>
</tr>
<tr>
<td>adult, basic CPR duration                                           90</td>
</tr>
<tr>
<td>adult, CPR first duration                                           90</td>
</tr>
<tr>
<td>compression ratio, field</td>
</tr>
<tr>
<td>95, 108</td>
</tr>
<tr>
<td>first, field                                                        87</td>
</tr>
<tr>
<td>general parameters                                                  86</td>
</tr>
<tr>
<td>hands-only                                                          50, 58</td>
</tr>
<tr>
<td>infant/child CPR                                                    91</td>
</tr>
<tr>
<td>Infant/child ventilation, field</td>
</tr>
<tr>
<td>96, 102, 108</td>
</tr>
<tr>
<td>option button, field                                                89</td>
</tr>
<tr>
<td>prompt, field                                                       97, 102-103, 109, 114</td>
</tr>
<tr>
<td>protocol-specific parameters                                       90</td>
</tr>
<tr>
<td>set interval before defibrillation                                  87</td>
</tr>
<tr>
<td>customer support                                                    77</td>
</tr>
<tr>
<td>customizing how information displays                                73</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>date modified, field                                                 82, 92, 98, 104, 110</td>
</tr>
<tr>
<td>default settings, restoring                                         31-32</td>
</tr>
<tr>
<td>defibrillators</td>
</tr>
<tr>
<td>configuration</td>
</tr>
<tr>
<td>84, 93, 100, 108</td>
</tr>
<tr>
<td>parameters                                                          106, 112</td>
</tr>
<tr>
<td>configuring a defibrillator                                         21</td>
</tr>
<tr>
<td>device volume                                                       83, 93, 99, 105, 111</td>
</tr>
<tr>
<td>parameter fields                                                    81</td>
</tr>
<tr>
<td>disk space                                                          10</td>
</tr>
<tr>
<td>display                                                             10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECG display                                                          83</td>
</tr>
<tr>
<td>email                                                               16, 30</td>
</tr>
<tr>
<td>errors                                                              69</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>factory settings, restoring                                         31</td>
</tr>
<tr>
<td>administration mode                                                34</td>
</tr>
<tr>
<td>Bluetooth connections                                              36</td>
</tr>
<tr>
<td>Bluetooth PIN, setting                                              84</td>
</tr>
<tr>
<td>configuration parameters                                           34, 40-41</td>
</tr>
<tr>
<td>defibrillation parameters                                           84</td>
</tr>
<tr>
<td>general CPR parameters                                             86</td>
</tr>
<tr>
<td>instructions for administrators                                    43, 82</td>
</tr>
<tr>
<td>language, setting                                                  44</td>
</tr>
<tr>
<td>NSA action                                                          88</td>
</tr>
<tr>
<td>option button                                                       89</td>
</tr>
<tr>
<td>overview parameters                                                82</td>
</tr>
<tr>
<td>retrieving configurations                                          37</td>
</tr>
<tr>
<td>self-test parameters                                               86</td>
</tr>
<tr>
<td>setting clock and date                                             34, 42</td>
</tr>
<tr>
<td>settings, modifying                                                34</td>
</tr>
<tr>
<td>transferring configurations                                        34</td>
</tr>
<tr>
<td>transferring configurations with a SD data card                    37</td>
</tr>
<tr>
<td>typical configuration tasks                                        33</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FRx</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000 Guidelines                                                    98</td>
</tr>
<tr>
<td>2005 and 2010 guidelines                                           92</td>
</tr>
<tr>
<td>administration mode                                               51-52</td>
</tr>
<tr>
<td>configuration tasks                                               49</td>
</tr>
<tr>
<td>configuration, sending                                            49, 55, 63</td>
</tr>
<tr>
<td>defibrillation parameters                                          93, 100</td>
</tr>
<tr>
<td>device parameters                                                  93</td>
</tr>
</tbody>
</table>
## Index

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>overview parameters</td>
<td>92, 98</td>
</tr>
<tr>
<td>owner's manual</td>
<td>92, 98</td>
</tr>
<tr>
<td>preparing for transfer</td>
<td>51</td>
</tr>
<tr>
<td>retrieving configurations</td>
<td>52</td>
</tr>
<tr>
<td>settings, modifying</td>
<td>49</td>
</tr>
<tr>
<td>indications for use, HeartStart Configure</td>
<td>7</td>
</tr>
<tr>
<td>infant/child CPR</td>
<td>87</td>
</tr>
<tr>
<td>infrared installation</td>
<td>55, 63</td>
</tr>
<tr>
<td>configuration</td>
<td>57</td>
</tr>
<tr>
<td>configuration, sending</td>
<td>63</td>
</tr>
<tr>
<td>defibrillation parameters</td>
<td>106, 112</td>
</tr>
<tr>
<td>owner's manual</td>
<td>104</td>
</tr>
<tr>
<td>parameters</td>
<td>104, 110</td>
</tr>
<tr>
<td>transferring configurations</td>
<td>57</td>
</tr>
<tr>
<td>getting started</td>
<td>25, 28</td>
</tr>
<tr>
<td>grouping information</td>
<td>72-73</td>
</tr>
<tr>
<td>Guidelines, 2010</td>
<td>50, 58</td>
</tr>
<tr>
<td>languages, setting for FR3</td>
<td>44</td>
</tr>
<tr>
<td>hands-only CPR</td>
<td>50, 58</td>
</tr>
<tr>
<td>help</td>
<td>78</td>
</tr>
<tr>
<td>Help pane, using</td>
<td>27</td>
</tr>
<tr>
<td>menu bar</td>
<td>27</td>
</tr>
<tr>
<td>HS1</td>
<td></td>
</tr>
<tr>
<td>2000 guidelines</td>
<td>57</td>
</tr>
<tr>
<td>2005 and 2010 guidelines</td>
<td>58</td>
</tr>
<tr>
<td>administration mode</td>
<td>59-60</td>
</tr>
<tr>
<td>configuration tasks</td>
<td>57</td>
</tr>
<tr>
<td>configuration, sending</td>
<td>63</td>
</tr>
<tr>
<td>defibrillation parameters</td>
<td>106, 112</td>
</tr>
<tr>
<td>owner's manual</td>
<td>104</td>
</tr>
<tr>
<td>parameters</td>
<td>104, 110</td>
</tr>
<tr>
<td>settings, modifying</td>
<td>57</td>
</tr>
<tr>
<td>metronome for compressions</td>
<td>87</td>
</tr>
<tr>
<td>No Shock Advised (NSA)</td>
<td>88</td>
</tr>
<tr>
<td>Action, field</td>
<td>88</td>
</tr>
<tr>
<td>CPR coaching</td>
<td>88</td>
</tr>
<tr>
<td>NSA Monitor Prompt Repeat Rate</td>
<td>89</td>
</tr>
<tr>
<td>pause timer, field</td>
<td>95, 101,107, 112</td>
</tr>
<tr>
<td>pause type, field</td>
<td>94, 100, 106</td>
</tr>
<tr>
<td>notes</td>
<td>8</td>
</tr>
<tr>
<td>IFU (instructions for use)</td>
<td></td>
</tr>
<tr>
<td>FRX owner's manual</td>
<td>92, 98</td>
</tr>
<tr>
<td>HS1 owner's manual</td>
<td>104</td>
</tr>
<tr>
<td>importing a configuration file</td>
<td>67</td>
</tr>
<tr>
<td>incompatibility issues</td>
<td>43</td>
</tr>
</tbody>
</table>
Index

O
offline connection state 43
opening a configuration 66
option button
   Analyze 89
   CPR 89
overview
   configuration 82, 92, 98,
   parameters 104, 110

P
primary and secondary languages 44
processor speed 10
prompts 96, 102, 108, 114
Proof of Purchase Certificate 9
protocol-specific CPR, FR3 82
protocol pause timer 95, 101, 107, 113

Q
Quick Reference Guide 9

R
ReadMe 12
ready connection state 43
record audio, field 83
representative in EU 2
requirements 10
reset width 71
restoring confirmation messages 75
retrieving a configuration
   FR3 33, 37
   FRx 49, 52
   HS1 57, 61
rhythm analysis and shock charge 85

S
security, software 11
self-test parameters, FR3 82
Send ECG, field 93, 99, 105, 111
serial number 15-16
shock 92, 98, 104, 110
software updates, checking for 28, 77
software, activating and registering 15-16
sorting information in columns 71
starting Configure 12
system administrator 20
system log
   Administration workspace 30
   messages 115
   opening the system log 69
   viewing 70
   working with the system log 69
system requirements 10

T
table columns, grouping for sorting 72
technicians 20
telephone support 77
test data card 86
Timer, field 113

tips 8

title bar 27

toolbar 27

trademarks 2

transfer FR3 configuration SD card 41

U

uninstalling Configure 13

update for hands-only CPR 50

update software 8, 77

US Food and Drug Administration 19

user-initiated rhythm analysis 85

user guide

FRx Instructions for Use 92, 98

HS1 Instructions for Use 104

user name 83, 92, 98, 104, 110

V

volume, field 83, 93, 99, 105, 111

W

wireless PIN 84

workspace 25, 28
[This page intentionally left blank]